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1
Introduction

Whether you are migrating Exchange Public Folders or PST files to SharePoint, Metalogix Content
Matrix Console - Public Folder Edition is an easy to use, convenient way of getting your data into
SharePoint. With its familiar copy-and-paste style user interface, you can quickly migrate your Public
Folder and PST file content into SharePoint, while preserving your valuable metadata.

Supported Source Systems
The following source systems are supported in Metalogix Content Matrix Console:
·

Exchange Public Folders (from Exchange 2000, 2003, 2007, and 2010)

·

Exchange PST Files
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Supported Target Systems
The following target systems are supported in Metalogix Content Matrix Console:
· SharePoint 2013 (Foundation and Server)
· SharePoint 2016
· SharePoint 2019
· SharePoint Server Subscription Edition
· Microsoft Office 365

Key Features
There are many advantages to using Metalogix Content Matrix Console, including the following:

Ease of use
Similar to the Windows File Explorer, Metalogix Content Matrix Console has a familiar, tree-based
copy-and-paste style user interface.

Valuable data retention
All version chains, metadata, user-edit information, and most views can be preserved.

Multiple site connections
Connect to multiple SharePoint sites, across any number of servers, for easy consolidation or
distribution of your SharePoint data.

Working remotely
Do all the heavy lifting for your SharePoint migration from the convenience of your own machine.
Metalogix Content Matrix Console connects to any SharePoint site that you can access with your
browser, even those outside your organization's intranet.

Batch work
Multiple list migration operations can be batched up for convenience, and re-run at any time. Run your
migrations at night and view the results/logs in the morning.

Compliance
All migration activity is done through the supported SharePoint APIs. There are no unsupported, direct
writes to the SharePoint database.

PowerShell functionality
PowerShell functionality is incorporated into the Metalogix Content Matrix User Interface (UI), and any
action in the UI can also be performed with PowerShell. Cmdlets are also included, so scripts can be
manually created and run.
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Product Announcements Splash Screen
When you launch the Metalogix Content Matrix Console, a splash screen displays with the latest
Metalogix Content Matrix product announcements. If you have internet access, you will receive
announcements directly from the Quest website. If you do not have internet access, the splash screen
displays offline text included with your Metalogix Content Matrix installation.
You have the option of preventing this screen from displaying in the future by clicking the Do not show
this screen again box. (If you select this option, display of the splash screen will resume the next time
you perform a Metalogix Content Matrix Console installation or upgrade.)

Automatic Updates
Metalogix Content Matrix Console can automatically check online to see if a more recent version of
the product is available for download. This takes place when Metalogix Content Matrix starts. To help
ensure that you are taking advantage of the latest features and fixes, it provides a direct line to
download and installation of new Metalogix Content Matrix builds.
Automatic Upgrades requires access to the internet. While Metalogix Content Matrix will check every
time it is opened, it is also possible to run a manual check. To do so, go to the main toolbar and choose
Help > Check for Updates.
If you are already running the latest build, the Check for Updates dialog will open and you will be
informed that you already have the latest version installed. If there is a new build available for
download, the Download and Install Update dialog will open.

Running the Automatic Update
When Metalogix Content Matrix checks for updates and finds a newer build available for download,
users will be prompted to update with the Download and Install Update dialog.

1. Click [Download] to directly download the latest build to your current machine.
The progress of the download is displayed in the Download progress bar.
NOTE: If you are accessing the internet through a proxy server, the here link can be clicked on to
open the proxy configuration dialog.
2. Once the download is complete, click [OK] to continue.
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The Download and Install Update dialog will still be open, but the Download button will be replaced
with the [Install] button.

You will have the option of installing the new build directly from here by clicking the [Install] button.
This will open the Installation guide. If you are continuing the installation process directly from this
dialog, then the Metalogix Content Matrix Console will close itself down, so the install process can be
run.
NOTE: When running the automatic upgrade process, only the latest build of the Metalogix Content
Matrix Console will be updated. Any installations of the Metalogix Extensions Web Service will have
to be updated manually. See the Metalogix Content Matrix Advanced Install Guide for details.
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2
Entering the License Key
You will be prompted to input an Activation License Key when launching the Content Matrix Console:
· for the first time after it has been installed if an existing license is not detected

OR
· after your license has expired.

NOTE: If users are not required to be a local administrators on the machine where Content Matrix is
installed, every user who launches a Console needs to enter a license key. If users are required to be
a local administrator, only the first user who launches a Console needs to enter a license key.

IMPORTANT: During installation, all Editions of the Console (SharePoint, eRoom, and Public Folder)
are installed. However, the license will only be activated for Editions that are covered by it. If an
Edition is not covered by the license, the message Invalid license: License key is not valid for the given
product. will display in the Activate License Key dialog.
If you are performing an online activation, you can also do it silently, using Powershell.

To enter a license key:
1. In the Activate License Key dialog, select I have a license key, and enter the license key provided
by Quest (the key can be copied and pasted into the provided space).
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NOTE: If you are updating from a Metalogix Content Matrix installation older than version 6,
select the I am updating from an older version and have an old-style key option, and enter the
key in the provided space (or paste into the first field from your clipboard).
2. Select the appropriate activation method.
NOTE: Most systems can use the Online activation method as long as the system has internet
access. If you are unable to use the online activation method due to security settings or lack of
internet access, the Offline activation option can be used.

Online Activation
NOTE: In order to activate your license, the following URL must be unblocked by your firewall:
https://license.metalogix.com
1. After entering the license key, select Online activation.
2. If you need to configure proxy settings:
§

Click the Set proxy… link.

§

Follow the procedure for Configuring Proxy Settings.

3. Click [Next].
Metalogix Content Matrix will contact the licensing server and attempt to authenticate the license
key, after which, on successful activation, a 'Congratulations!' message will be returned, and the
license key will be active and in use.
4. Click [Finish] to complete the process.
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Offline Activation
NOTE: The offline activation option is generally used in cases where you cannot use the online
activation due to security settings or lack of internet access. This option will still require some
internet access, but allows for the authentication to be done from another machine that is not as
restricted by security or has a connection to the internet.
1. Select Offline activation.
2. Click [Next].
A Generate Activation Request dialog displays with a different key. This key can be copied from
the window, or the Save to file option can be used to save the key into a text file (in case it needs
to be copied to another machine).
3. Copy the Activation URL (listed under the Activation Request) to a web browser that has internet
access.
Alternately if the system the Metalogix Content Matrix Console is on does have internet access
through a Web browser, click Go to automatically open a web browser to this URL.
4. On a machine that has internet access, use the Activation URL to navigate to the Offline Activation
page.
5. Either:
§

Enter the key into the Activation data text box.

OR
§

If the key was saved to a file, select Browse and navigate to the file.

6. Click [Activate].
Upon successful activation, a new key displays in the text box.
7. Do one of the following:
§

To save the key as a DAT file, click [Download file].

OR
§

To copy the key to the clipboard (if the license will be activated on the same machine), click
[Copy text].

8. Click [OK] to continue.
9. Return to the Activate License dialog.
10. If the Generate Activation Request window is still active, click [Next]. to the Enter your Activation
Response window.
11. Use one of the following options:
§

If you copied the key to the clipboard on the same machine, paste it into the window.

§

If you saved the key to a DAT file, navigate to, and select the DAT file.

12. Click [Next]. The license key will be active and in use.
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13. Click [Finish] to complete the process.

Checking the Current Content Matrix Console
License
To check the status of the license key in use, open the About dialog. Here, information such as the
license type, expiration date (if any), size limitations for migrations, and how much data has already
been migrated can be seen.
NOTE: If an offline license is used, the offline activation process will need to be used to do this
update instead, unless the system that the Metalogix Content Matrix Console is installed on has
internet access.

To check the current license:
1. In the Content Matrix Console ribbon toolbar, choose Help > About.
2. In the dialog that opens, click [Refresh]. This will initiate a refresh of this data from the licensing
servers and update the information.
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3
Selecting the SQL Database You
Want to Connect to
The first time you launch the Content Matrix Console you will be prompted to select the SQL database
that you want to connect to. Options are:
· Connect to Job Database (SQL Server)*

* NOTE: The option Connect to Distributed Database (SQL Server) is disabled as it is only valid for
SharePoint Edition.
· Connect to New Job List (SQL Server Compact 4.0* Required)
· Connect to Existing Job List (SQL Server Compact 4.0* Required)

NOTE: The use of SQL CE in a production environment is discouraged because of the following
limitations:
§

It uses a single .lst file that is less robust and reliable and may be corrupted after the database
reaches 4 GB.

§

Data compression is not supported.

§

Support for large objects is limited.

§

Microsoft support for SQL CE has ended.

If you still want to use SQL CE, SQL Server Compact 4.0 must already be installed on your machine.
You can download it from Microsoft, install it, then restart the Console.
NOTE: If you have upgraded from version 9.3 or earlier and are using SQL CE (.lst) files but SQL
Server Compact is not installed, a pop-up will display. You will be given the option of either installing
SQL Server Compact 4.0 or selecting a different Job database.

To create or connect to a full SQL database:
IMPORTANT: If you are connecting to an Azure SQL database, the database must already have been
created via Azure Portal. You cannot create or delete an Azure SQL database from within Content
Matrix.
1. From the Please connect to a job database dialog, select Connect to Job Database (SQL Server).
2. Complete the Connect to SQL Server dialog:
§ If you are connecting to an on premises SQL database, create (using the New Database option)

or select the database you want to use.
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§ If you are connecting to an Azure SQL database, select the database that has been created in

Azure Portal for use by Content Matrix. (Note that the New Database and Delete Database
options will be disabled.)

3. If you want to use an encrypted connection to the database, check the Encrypt Connection box.
NOTE: If the certificate used for encryption is not trusted, you will also need to check the Trust
Server Certificate box.
4. Select an Authentication method for connecting to SQL server.:
· Use Current Windows User

OR
· Use SQL Server Login

NOTE: Currently, Use SQL Server login is the only valid option for an Azure SQL server.
5. Click [OK].

Metalogix® Content Matrix Public Folder Edition
Selecting the SQL Database You Want to Connect to

18

4
Content Matrix Console End User
Interface
The Metalogix Content Matrix Console User Interface (UI) is simple and easy to use. There are three
high level components to the configurable interface:
·

Explorer View 1 - At minimum, the interface will always display one Explorer Control, providing
multiple ways to view the content for any active connections to source and target environments.

·

Explorer View 2 - A second explorer control can be displayed simultaneously. Having two explorers
visible allows the user to simultaneously view two different parts of the connected content set. For
example, in many cases it makes sense to show a migration source on the left in Explorer Control
1, and a SharePoint migration target on the right in Explorer Control 2.

·

Job List - Beneath the Explorer Control windows is a Job list that shows the history of migration
jobs and other tasks that have been run or batched in Content Matrix.

More information on these UI components is provided in the topics that follow.

Main (Ribbon) Toolbar
At the top of the Metalogix Content Matrix Console is a ribbon toolbar allowing access to the following
five menu group settings:
·

Connection

·

View
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·

Settings

·

Help

The Metalogix Content Matrix Console menu ribbon can be expanded or minimized to fit the user's
needs. When expanded, a set of options will be available depending on the selected menu heading.

When minimized, options will only be visible when a menu heading is selected. Otherwise, only menu
headings will show. The minimize and expand options can also be accessed by right-clicking an option
in the ribbon itself. This opens a context (right-click) menu where the Minimize the Ribbon option can
be selected or deselected.

Quick Access Toolbar
The Quick Access Toolbar can be accessed above the ribbon. The Quick Access Toolbar can also be
moved just below the ribbon by selecting the drop down menu (on the top left-hand side) and choosing
Show Quick Access Toolbar Below the Ribbon, or it can be placed back above the ribbon by choosing
Show Quick Access Toolbar Above the Ribbon. Any option that is available under one of the menu
group headings can have a shortcut for the option placed into the Quick Access Toolbar. This can be
done by right-clicking on the option in the ribbon, and choosing Add to Quick Access Toolbar.

Shortcuts can also be removed from the Quick Access Toolbar either by selecting the option within the
ribbon and opening the context (right-click) menu, or by selecting the shortcut option itself, opening the
context (right-click) menu, and choosing Remove from Quick Access Toolbar.
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Explorer Control View Tabs
The Metalogix Content Matrix Console user interface uses an Explorer Control style window which
allows you to navigate, view, and select the desired content for migration. The Explorer Control
window is broken up into three separate tab options, each of which contains its own set of options for
viewing content and data. They are:
·

Explorer View Tab

·

Items View Tab

·

Browser View Tab

Explorer View Tab
The Explorer view tab allows you to navigate through your various connections in a tree view. You can
navigate to and selected a desired SharePoint site collect, site, list/document library or sub-folder or a
under a specific connection or navigate to a specific Exchange Server or PST file.
There are a set of filtering options that are available in this tab, as well as a set of ordering options.
This allows you to display, sort, and filter all of your connections as desired.
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There are three primary Filtering options: Text Filter, Connections Filter, and Status Filter.
·

Text Filter: For example, if you only want to view connections that contain "2010" in the URL, you
can enter "2010" in the Filter text box, and click the Filter button to the right of the text value. The
filter will then be applied to all connections in that Explorer View tab, and only connections that
contain a "2010" value will be displayed.

NOTE: To remove a text box filter, delete the filter value from the text box and re-run the filter
action.
·

Connections Filter - This option consists of a drop down menu that allows you to filter by
connection type. By default, all of these options are selected, but one or more can be DE-selected.

·

Status Filter - This option consists of a drop-down list with the various connection status options.
§

NotChecked – Metalogix Content Matrix has not tried to validate the connection yet.

§

Checking - Metalogix Content Matrix is currently trying to validate the connection.
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§

Valid - Metalogix Content Matrix has tried to validate the connection, and has been successful.
A connection has been established.

§

Invalid - Metalogix Content Matrix has tried to validate the connection, and has been
unsuccessful. A connection has not been established.

§

Warning - Metalogix Content Matrix has tried to validate the connection, and has been
successful. A connection has been established, however, a warning message has been given.

By default all of the status types are selected but, as with the Connections Filter, one or more can be
de-selected.

You can also Sort by
·

Default - All of the connections in the order they were added.

·

Type -These are the same types that are listed in the Connections Filter drop down menu. When
selected, connection types will be sorted in the following order:
§

Exchange PST files

§

Exchange Servers

§

SharePoint farms (this includes all Web App and Farm connection to a server, as well as
Database connections)

§

SharePoint Site connections, which include Site connection types, and Read-only connections to
SharePoint

You can combine various filter and sort options.

Items View Tab
The Items View tab displays any items/documents that exist directly under the selected node (that is,
the content of any subfolders under the selected node-will not be displayed), along with column
metadata.
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There are four main options that are available through this tab. These options are:
·

Search – To perform a full or partial text search, enter the string in the search box then either and
either press <Enter>, or click the magnifying glass icon to run the search.
NOTE: The search will be run on the name column (the FileLeafRef) by default, but you can select a
different column to search from the drop-down to the right of the search box.

·

Refresh - This button will refresh all of the items in the Items View tab.

·

Show/Hide Version History - This button option is only available when the selected document
library/list has versioning configured. When this button is selected the Items View tab will be
divided into two sections, a top section displaying all of the items/documents and a bottom section
displaying all of the versions for the selected item/document.
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When an item/document is selected in the top window, all of that item/document's version’s will
be listed in the bottom half of the window. You can then look at the metadata for each
item/document version that exists. This option can be combined with the Show/Hide Properties
button.
If the Show Version History button has already been selected, this will change to be a Hide Version
History button instead. You can use this option to stop looking at item/document version histories.
·

Show/Hide Properties - The Show Properties button allows you to see a list-style view of the
available fields (columns) and their values, for a selected item/document. Any value listed in dark
text can be edited and within the window.

The fields in the Properties window can also be ordered by category, or alphabetically. By default, the
fields are ordered by category, and are listed alphabetically within each category. If listed
alphabetically, then all property fields (columns) will be listed in alphabetical order, with no breakdown
by category. There are two buttons at the top of the Properties window that can be used to determine
what ordering type is used. This option can be combined with the Show/Hide Version History button.
If the Show Properties button has already been selected, this will change to be a Hide Properties
button instead. Use this option to close the Properties window.

Browser View Tab
The Browser View displays a view of the content as it would be seen in a web browser for a selected
node. It is also available if selecting a single item in the Items View. When selected, this tab will display
a fully functioning web browser view of the selected content. You can use this Browser View to
navigate or work with their content, the same way they would through a normal web browser window.

Metalogix® Content Matrix Public Folder Edition
Content Matrix Console End User Interface

25

Jobs List
Jobs in Metalogix Content Matrix Console can be managed from the Job List. Jobs are listed for
migration actions that have already been run, as well as for actions that have been saved.
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5
Connecting to Public Folders
There are two basic types of connections that can be made to Public Folders: Connections to Exchange
Servers and Connections to PST.

Connecting to an Exchange Server
To connect to an Exchange Server:
1. In Metalogix Content Matrix Console ribbon toolbar, choose Connection > Connect to Exchange
Server to display the Exchange Server Logon dialog.

2. For Mailbox profile, select a value from the drop-down.

NOTE: If you selected Outlook, all settings will be automatically filled in.
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3. Use the information in the following table to determine the appropriate action to take.
If you selected ...

Then ...

Custom profile settings

go to the next step.

Outlook

go to step

4. Enter a User mailbox (e.g. jsmith@company.com). Then specify whether it is the mailbox of the
Currently logged on user or Different user.
5. In the Server settings section, enter the name of the Exchange server and select a Connector
type:
· Exchange Web Services (EWS) - This is the Exchange web services connector type. When this

connector is selected, any public folder can be opened in Metalogix Content Matrix. Please note
that for this connector type only eml message format is supported as the output file format for
migration into SharePoint. EWS must be allowed on the Exchange server.
NOTES:
§ This option is not available if you selected Outlook as the Mailbox profile.
§ EWS is not supported for Excahange Online because Microsoft has deprecated EWS basic

authentication.
·

Messaging Application Programming Interface (MAPI) - This connector type can be used only
if Outlook (32bit) is installed on the local computer. When MAPI is selected, only the logged on
user can browse and view public folders for which they have been given rights. However, this
connector type supports msg as well as eml output formats for migration. With the msg file
format, the full, original Outlook fidelity is retained and the attachment and message header
and body are all contained within a single msg file in SharePoint. If Outlook is installed as the
default mail client, and users double-click on the migrated msg file in the web browser in
SharePoint, the message will open in Outlook and all Outlook actions are available to the user
directly, e.g., Reply, Forward, etc.

·

Messaging Application Programming Interface (Redemption) - This is the preferred
connection method. This connector type requires CDO (Collaboration Data Objects) or Outlook
(32bit or 64bit) installed on the local computer. Other features are the same as with MAPI
connector type.
Environment

MAPI

Redemption

32bit OS and 32bit Outlook

32bit OS and CDO (Collaboration Data
Objects)

-
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-

64bit OS and 64bit Outlook

(Metalogix Content Matrix
Console - Public Folder
Edition32.exe)

64bit OS and 32bit Outlook

64bit OS and CDO (Collaboration Data
Objects)

-

(Metalogix Content Matrix
Console - Public Folder
Edition32.exe)

NOTES:
§ To apply the Redemption connector type in 64bit OS and 32bit

Outlook (or CDO) environment, Metalogix Content Matrix
Console - Public Folder Edition has to be started via the
Metalogix Content Matrix Console - Public Folder Edition32.exe
file instead of the conventional Metalogix Content Matrix
Console - Public Folder Edition.exe file.
§ Metalogix Content Matrix Console - Public Folder Edition32.exe

is located under: C:\Program Files (x86)\Metalogix\Metalogix
Content Matrix Console\Public Folder Edition\.
6. In case of EWS Connector type, either:
§ select the Server version from the drop-down and enter the EWS URL and OWA URL then click

[OK].
OR
§ click [Discover] button to open the Auto Discover dialog. Enter the User mailbox and user

credentials if necessary then click [Start].
Exchange Server settings in the Exchange Server logon dialog will be filled in automatically.
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Connecting to a PST File
To connect to a PST file:
1. In the Metalogix Content Matrix Console ribbon, choose Connection > Connect to PST to display
the Connect to PST File dialog.

2. For PST file, either:
§

enter the location of the PST file

OR
§

click [Browse] and navigate to the desired PST file.

NOTE: The Connect to PST feature requires Outlook (32bit or 64bit).
Environment

Connect to PST

32bit OS and 32bit Outlook
32bit OS and CDO (Collaboration Data
Objects)

-

64bit OS and 64bit Outlook
(Metalogix Content Matrix Console - Public Folder
Edition32.exe)
64bit OS and 32bit Outlook

64bit OS and CDO (Collaboration Data
Objects)

-
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NOTES:
§ To apply the Redemption connector type in 64bit OS and 32bit Outlook (or CDO) environment,

Metalogix Content Matrix Console - Public Folder Edition has to be started via the Metalogix
Content Matrix Console - Public Folder Edition32.exe file instead of the conventional Metalogix
Content Matrix Console - Public Folder Edition.exe file.
§ Metalogix Content Matrix Console - Public Folder Edition32.exe is located under: C:\Program

Files (x86)\Metalogix\Metalogix Content Matrix Console\Public Folder Edition\. Metalogix
Content Matrix Console - Public Folder Edition32.exe does not support the SharePoint Local
Object Model (OM) connection.
3. If the PST file is password protected, click the Use password radio button, then enter the password
for the PST file. If you check the Remember my password box, the next time that Metalogix
Content Matrix is started it will connect to the PST file without the need to type in the password
again.
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6
Connecting to SharePoint
The following basic connection adapters are supported for making connections to SharePoint from
Metalogix Content Matrix Console:
· A local connection to a SharePoint site or server *
· A remote connection to a SharePoint site or server
· A client side object model (CSOM) connection for SharePoint Online at the site level

* As of version 9.3 the Metalogix Content Matrix Console client application requires Microsoft .NET
Framework 4.7.2 to run. Since this .NET requirement applies to the machine on which Metalogix
Content Matrix is installed, Metalogix Content Matrix cannot make a local Object Model (OM)
connection on a SharePoint 2007 or 2010 environment, because SharePoint 2007 and 2010 require an
earlier version of the .NET Framework (v.3.5), which prohibits Metalogix Content Matrix from
completing the connection. Because of this, any migration ‘jobs’ configured to connect to SharePoint
2007 and 2010 environments using a Local OM connection type will cease to work, and these jobs will
need to be recreated for use over MEWS or DB.
The following table identifies the connection adapter types for each supported version of SharePoint:
SharePoint Server
Type

Microsoft Office 365

Local Object Model (OM)
Connection (Metalogix
Content Matrix Console installed on server)*

Remote Object Model (OM)
Connection (Metalogix
Extensions Web Service
installed on remote server)

-

-

SharePoint Client Side Object
Model (CSOM) Connection

Microsoft SharePoint
2013

-

Microsoft SharePoint
2016

-

Microsoft SharePoint
2019

-

**

**
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SharePoint Server
Type

Local Object Model (OM)
Connection (Metalogix
Content Matrix Console installed on server)*

Remote Object Model (OM)
Connection (Metalogix
Extensions Web Service
installed on remote server)

Microsoft SharePoint
Server Subscription
Edition

SharePoint Client Side Object
Model (CSOM) Connection

--

**
* Metalogix Content Matrix Console - Public Folder Edition32.exe does not support the SharePoint
Local Object Model (OM) connection.
** Currently, if Content Matrix is installed in a FIPS-enabled environment, you cannot connect/migrate
to SharePoint 2019. For SharePoint Server Subscription Edition in a FIPS-enabled environment, you
can only connect using a remote object model connection. See Errors Connecting to SharePoint
2019 or SharePoint Server Subscription Edition in a FIPS-Enabled Environment for more
information.

Connecting to a SharePoint On Premises Site or
Server
The same connection methods and options can be used for a normal connection to SharePoint and a
read-only connection to SharePoint. The below steps can be used for both connection types. The readonly connection can be used to help users keep their source and target connection separate (and it can
help ensure that users do not accidentally migrate any data to a source connection).
NOTES:
· When making a secure connection to a SharePoint URL that is configured with TLS, Content Matrix

can use any version of TLS that is compatible with .NET Framework 4.7.2. The default version of
TLS used by the operating system on the machine from which you are connecting will be used by
Content Matrix.
· Currently, connections to a SharePoint server cannot be made for SharePoint 2019 in a FIPS-

enabled environment. (See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription
Edition in a FIPs-Enabled Environment for more information.)

To connect to a SharePoint site or server:
In the Metalogix Content Matrix ribbon, choose Connection > Connect to SharePoint.
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To complete the Connection Options tab:
1. For Address, enter either the URL or IP address of the SharePoint site or server to which you want
to connect.
Note that the drop-down menu displays a list of previous connections.
2. For Target Type, select the connection type. Use the information in the following table for
guidance.
If you want to connect…

Select …

directly to a SharePoint site

Site.

to a specific Web application on a
SharePoint server

Web App.
NOTE: This option can only be used if using the
Local or Metalogix Extensions Web Service
connection type.

to a SharePoint instance at the
Farm/server level
(which will allow you to see all site
collections for all Web Application on the
selected server)

Farm.
NOTE: This option can only be used if using the
Local or Metalogix Extensions Web Service
connection type.
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3. Select a Connection Type from the drop-down. Use the information in the following table for
guidance.

If …

Select …

Notes

you want to have
Metalogix Content
Matrix choose the
connection adapter
type that makes the
most sense for the
target SharePoint
instance

Auto Detect

·

If the SharePoint instance is local
(installed on the same machine as the
Metalogix Content Matrix Console), the
Local Connection (SharePoint Object
Model) will be used

·

If the SharePoint instance is remote
(installed on another machine), and the
Metalogix Extensions Web Service is
installed, the Remote Connection
(Metalogix SharePoint Extensions
Web Service) type will be used.

Metalogix Content
Matrix Console is
installed locally (that
is, on the same
SharePoint server or
one of its Web Front
Ends (WFEs)

Local Connection
(SharePoint Object
Model)

This connection type
·

is generally recommended for the
target SharePoint instance if possible,
to help with performance and to help
provide the product with greater
leverage into SharePoint.

AND
·

the account used for the connection.
must be the logged in user and have
the following permissions:
·

Farm Administrator

·

Site Collection Administrator

·

DB_Owner on the Content
Database (to allow the connecting
user access to the local SharePoint
Object Model).

NOTE: Currently, a local connection to a
SharePoint server cannot be made for
SharePoint Server Subscription Edition in a
FIPS-enabled environment. (See Errors
Connecting to SharePoint 2019 or
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If …

Select …

Notes
SharePoint Server Subscription Edit in a
FIPs-Enabled Environment for more
information.)

·

Metalogix Content
Matrix Console is
not installed
locally

The connecting account requires Full
Remote Connection
Control over the content being connected
(Metalogix
to and migrated. Additional permissions are
SharePoint Extensions
provided through the use of the Metalogix
Web Service)
Extensions Web Service.

AND
·

NOTE: Although it is strongly
recommended that the version of the
Metalogix Extensions Web Service
(MEWS) match the installed version of
Content Matrix, you can override it to use
an earlier MEWS version.

Metalogix
SharePoint
Extensions Web
Service (MEWS) is
installed on the
SharePoint
server/WFE to
which you are
connecting

NOTE: As of version 9.5, Content Matrix no longer supports CSOM connections to SharePoint on
premises. The option will work for backward compatibility with existing jobs, but if you select it
for a new connection, a pop-up warning will display.
4. For Authentication Type, select the method to use when trying to connect to the specified
SharePoint instance.
Use the information in the following table for guidance.

If …

Select ….

you want Metalogix Content Auto Detect
Matrix to automatically
check against the SharePoint
environment

Notes
Metalogix Content Matrix will check
for non-Office 365 authentication
types listed in the drop-down (in order),
and use the first method that is found.
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If …
you want to connect to the
SharePoint environment
using the currently logged in
Windows user’s credentials

·

you selected Metalogix
SharePoint Extensions
Web Service as the
Connection Type

Select ….

Notes

Windows
Authentication

·

The logged in user credentials are
used by default; however, other
credentials that use this
authentication method can also be
entered.

·

This is the authentication type that
most environments use.

·

Most setups for Forms Based
Authentication are supported.

·

This method is limited to the
Metalogix SharePoint Extensions
Web Service connection type
because it authenticates through
IIS and not Active Directory (AD).

Forms Based
Authentication

AND
·

you want to connect
using Forms Based
Authentication

you want to connect through Web Browser
a Web browser
Authentication (Not
Auto Detected)

This option is not searched for within
the “Auto Detect” option, and needs to
be manually set.
In order for the Metalogix Content
Matrix Console to logon to the system,
users must have logged on to the
system being connected to through the
web browser on that system first (only
before the initial connection). Since
this is all done using the Web browser
for authentication, the credentials
section of the window will be grayed
out (since it is not needed), and it is
limited to the MetalogixSharePoint
Extension Web Services Connection
Type because it authenticates through
IIS and not the Active Directory (AD).
NOTES:
· Because this connection method

uses cookies from the browser, it
may require multiple logins when
running a single migration.
However, this is only likely if the
migration is running for a long
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If …

Select ….

Notes
session; this is mainly determined
by the web browser settings for
authentication. In the event that a
login is required, a dialog box
appears that lets users log in. After
the user logs in, the migration will
continue from where it left off.
· If you are planning to run a job

using a PowerShell script, make
sure the PowerShell console is
closed before you make the
connection using this method.
Otherwise, an error will occur
when you attempt to run the
PowerShell job.
5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint
site/server. Use the information in the following table for guidance.
NOTE: This option is disabled if you selected Local Connection (SharePoint Object Model) or
Web Browser Authentication (Not Auto Detected).
If you want to …

Then …

use the current Windows
user's authentication
credential

Select the (default) <Domain>\<user> radio button.

use different authentication
credentials

·

Select the Different User radio button, and

·

Enter the applicable user name and Password.

In cases where alternate credentials are entered, it is
recommended that you select the Remember my password
check box so Metalogix Content Matrix will automatically
remember that user account password. This is especially
important if you chose Web Browser Authentication, as
credentials must be stored in the Credential Manager vault
before the connection is made.
6. If you need to configure proxy settings:
a) Select the Proxy Options tab.
b) Follow the procedure for Configuring Proxy Settings.
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7. If you want to Add or Remove certificates to be included when connecting to SharePoint:
a) Select the Included Certificates tab.
Please see the Connecting with Certificates for more details on connecting to SharePoint
instances that require certificates.
b) After all of the desired connection options have been set, for all options tabs, click [OK] to
establish the connection.
If you selected a connection type other than Site, the Limit Site Collections dialog displays, giving
you the option to limit the site collections to include in your connection (when importing an xml file
with the list of URLs you want to include). This is useful if the environment you are connecting to
includes a very large number of site collections. In this case, limiting displayed site collections can
improve performance.

NOTE: If you want to View Sample xml, click the link on the dialog. The xml file you import must
follow the same format as this sample.
8. Either:
§

Click [Yes – Import from XML] to specify the URLs of the sites you want to include in the
connection, then browse/upload the file

OR
§

Click [No – Continue with Connection] to add all sites within the selected scope to the
connection.
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If Metalogix Content Matrix successfully makes the connection, a new node will appear in the Explorer
View, and you can expand this node and navigate through the SharePoint objects.

Overriding the Version of the Metalogix Extensions Web
Service (MEWS) When Making a SharePoint Connection
It is strongly recommended that when you select Remote Connection (Metalogix SharePoint
Extensions Web Service) to connect to SharePoint, the version of MEWS is installed on the remote
server is the same as the installed version of Content Matrix Console. However, when you select
MEWS as the connection type, you will have the option to Override the MEWS Version and specify an
earlier MEWS Version (in the format n.n.n.n) when making a connection. Note that you will receive a
warning message that the installed version of MEWS may be incompatible.

You can hide the warning message for any new connections and re-connections made during the
current session by checking the Do not show this message until application restarts box.
IMPORTANT: You cannot update the MEWS version once the connection has been created.
If the MEWS version is overridden, the job log will display the warning message. (If both the source and
target connections use an older version of MEWS, an entry will display for each.)

Metalogix® Content Matrix Public Folder Edition
Connecting to SharePoint

40

Connecting to SharePoint Online
Metalogix Content Matrix Console can make a site level connection to a SharePoint Online
environment.

To connect to SharePoint Online:
In the Metalogix Content Matrix ribbon, choose Connection > Connect to SharePoint.

Make sure the selected Target Type is Site.

To complete the Connection Options tab:
1. For Address, enter either the URL or IP address of the SharePoint site or tenant to which you want
to connect.
Note that the drop-down menu displays a list of previous connections.
2. For Target Type, select the connection type. Use the information in the following table for
guidance.
2. For Target Type, select Site.
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3. For Connection Type, select Remote Connection (SharePoint Client Side Object Model O365).
NOTE: If you accept the default (Auto Detect), this option will be detected automatically.

4. For Authentication Type, select the method to use when trying to connect to the specified
SharePoint instance. When connecting to Office 365, the two main Authentication Types will be
Office 365 OAuth/Standard/ADFS Authentication and Office 365 Web Browser Authentication (Not
Auto Detected). Use the information in the following table for guidance.

For a SharePoint Online connection that uses"modern" (not "legacy") authentication, you must select
one of the O365 OAuth Authentication options or Office 365 Web Browser. If the account is also part
of a SharePoint Online Multi-Factor Authentication Policy, Office 365 Web Browser or O365 OAuth
with MFA Authentication must be used.
For more information about legacy vs. modern authentication, refer to the Microsoft Support article
How modern authentication works for Office 2013 and Office 2016 client apps.)
If …

Select ….

Notes

you want Metalogix Content Auto Detect
Matrix to automatically
check against the SharePoint
environment

Metalogix Content Matrix will check
for authentication types listed in the
drop-down (in order), and use the first
method that is found.
NOTE: At the time you click [OK] to
complete the connection, a pop-up
box will display that asks if you want
to use Office 365 OAuth. See Using
Office 365 OAuth Authentication to
Connect to SharePoint Online for
details.

· you want to connect to

Office 365
Office 365 OAuth, Office
OAuth/Standard/ADFS
365 – Standard editions, or Authentication*
systems with ADFS

By default the logged in user
credentials will be unavailable, since
this uses the Windows authentication
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If …

Select ….

Notes

AND

method, and the Office 365 credentials
will need to be entered.
NOTE: At the time you click [OK] to
complete the connection, a pop-up
box will display that asks if you want
to use Office 365 OAuth. See Using
Office 365 OAuth Authentication to
Connect to SharePoint Online for
details.

· MFA is not being used

your account requires the
use of Multi-Factor
Authentication (MFA)

Office 365 OAuth with
MFA Authentication
(Not Auto Detected)*

you want to connect through Web Browser
a Web browser
Authentication (Not
Auto Detected)

With this authentication type, you do
not have to enter account credentials
in Content Matrix, and the Connect As
options will be disabled.
This option is not searched for within
the “Auto Detect” option, and needs to
be manually set.
In order for the Metalogix Content
Matrix Console to logon to the system,
users must have logged on to the
system being connected to through the
web browser on that system first (only
before the initial connection). Since
this is all done using the Web browser
for authentication, the credentials
section of the window will be grayed
out (since it is not needed), and it is
limited to the Metalogix Extensions
Web Service Connection Type because
it authenticates through IIS and not the
Active Directory (AD).
NOTES:
· Because this connection method

uses cookies from the browser, it
may require multiple logins when
running a single migration.
However, this is only likely if the
migration is running for a long
session; this is mainly determined
by the web browser settings for
authentication. In the event that a
login is required, a dialog box
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If …

Select ….

Notes
appears that lets users log in. After
the user logs in, the migration will
continue from where it left off.
· If you are planning to run a job

using a PowerShell script, make
sure the PowerShell console is
closed before you make the
connection using this method.
Otherwise, an error will occur
when you attempt to run the
PowerShell job.
you want to connect through Office 365 Web Browser This option works the same as Web
a Web browser using
Authentication
Browser Authentication (Not Auto
authentication for Office
Detected) except:
365
· it looks for more specific Office 365
cookies
· it requires that users first log into

Office 365 through the browser
· instead of allowing multiple logins,

only one "request" for data can be
made at a time, which ensures that
no data is missed or lost due to the
system locking from too many
requests (but which may result in a
slower connection).
you want to make a sitelevel connection to a GCC
High site using O365 User
Provided Authentication

Office 365 User
Provided
Authentication
(hidden by default)

You must first run a utility provided by
Quest Support and enable the setting
EnableUserProvidedAuthentication.
Refer to the Quest Support Knowledge
Base article Enabling User Provided
Authentication in Content Matrix for
details.

* If you are connecting to SharePoint Online using OAuth authentication and you used a custom
domain as the Address, you will also need to check the Override SharePoint Online Tenant
Domain Name and enter the default tenant domain name (which can be found at
https://admin.microsoft.com/Adminportal#/Domains) to allow Content Matrix to route the
request to the proper region.
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5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint
site/server. Use the information in the following table for guidance.
NOTE: This option is disabled if you selected Office 365 OAuth with MFA Authentication, or Web
Browser Authentication (Not Auto Detected).
If you want to …

Then …

use the current Windows
user's authentication
credential

Select the (default) <Domain>\<user> radio button.

use different authentication
credentials

·

Select the Different User radio button, and

·

Enter the applicable user name and Password.

In cases where alternate credentials are entered, it is
recommended that you select the Remember my password
check box so Metalogix Content Matrix will automatically
remember that user account password. This is especially
important if you chose Web Browser Authentication, as
credentials must be stored in the Credential Manager vault
before the connection is made.

6. If you want to Add or Remove certificates to be included when connecting to SharePoint:
a) Select the Included Certificates tab.
Please see the Connecting with Certificates for more details on connecting to SharePoint
instances that require certificates.
b) After all of the desired connection options have been set, for all options tabs, click [OK] to
establish the connection.
If Metalogix Content Matrix successfully makes the connection, a new node will appear in the Explorer
View, and you can expand this node and navigate through the SharePoint objects.
NOTE: Should the log file ever show a "could not find site on remote SharePoint server" exception
message when working with CSOM connections, simply restart the CSOM service on all machines
running the Metalogix Content Matrix console and then rerun the action.
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Using Office 365 OAuth Authentication to Connect to
SharePoint Online
Office 365 OAuth Authentication is a token-based authentication method that can be used as an
alternative to Standard/ADFS Authentication to reduce throttling.
If Multi-Factor Authentication is set up for the tenant and enabled for the account (as described in the
Microsoft TechNet article SharePoint Online - O365: Set up Multi-Factor Authentication), you can
connect using Office 365 OAuth with MFA Authentication as an alternative to Office 365 Web
Browser authentication.

Registering the Metalogix Content Matrix SharePoint Client
Application for OAuth Authentication
The very first time OAuth Authentication is selected, the application Metalogix Content Matrix
SharePoint Client must be registered for the tenant.
IMPORTANT: Prior to version 9.2, the Metalogix SharePoint Migration Client application was used
for OAuth Authentication. Jobs created before version 9.2 (including those that use PowerShell) will
continue to use this application (as long as it is still registered in Azure Active Directory). Starting with
version 9.2, all jobs using OAuth Authentication will use the Metalogix Content Matrix SharePoint
Client application.

Required Permissions
At a minimum, the following permissions are required to register and provide consent for the Metalogix
Content Matrix SharePoint Client application.
· For a site-level connection, the account must have a minimum of Site Administrator and

Application Administrator permission roles.
· For a tenant-level connection, the account must have a minimum of Application Administrator

permission role.

Providing Consent to Grant the Application Requested Permissions
The first time a Content Matrix user attempts to connect to SharePoint Online using Office 365 OAuth
Authentication, a dialog displays requesting that you grant the permissions that the application needs
to perform migrations.
A Global Administrator can check the Consent on behalf of your organization box, which will prevent
this dialog from displaying for other users. If the account is not a Global Administrator, the Consent on
behalf of your organization option will be hidden.
IMPORTANT: If a Global Administrator does not consent on behalf of the organization, each
Content Matrix user who attempts to connect using Office 365 OAuth Authentication for the first
time must sign in with an account that has the Application Administrator and SharePoint
Administrator permission role.
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After [Accept] is clicked, the connection is created (and the application will be registered if it does not
already exist in Azure Active Directory). In addition, the token cache file ConnectionsTokenCache.dat
is created in the AppData/Roaming/Metalogix folder. (Note, if you have used OAuth Authentication in
an earlier version of Content Matrix, this file will already exist.)

Completing a Connection to SharePoint Online Using Office 365
OAuth Authentication
When you select one of the Office 365 OAuth authentication types, before making a connection to
SharePoint Online, a pop-up specific to the authentication type will display, as described in the
following table.
NOTE: If you click the Do not show the message again. box, Content Matrix will continue to use the
selected option and no longer display the pop-up. You can resume having the pop-up display by
clicking Reset Configuration Options on the ribbon toolbar Settings tab.
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If you selected...

Then ...

Auto Detect or Office365
OAuth/Standard/ADFS Authentication

the pop-up will prompt you to use the Office 365
OAuth option.

Choose either [Yes - Use OAuth] or [No - Use Office
365 Standard/ADFS].
Office 365 OAuth with MFA Authentication
(Not Auto Detected)

the pop-up will describe this authentication type.

Signing into your O365 Account to Use Office 365 OAuth
Authentication
When prompted to sign into your O365 account, for Auto Detect or Office365 OAuth/Standard/ADFS
Authentication, you must use the account you specified as the Connect As account in Content Matrix.
The connection will fail if you try to sign in with another account. (This is not an issue with Office 365
OAuth with MFA Authentication, which does not use a Connect As account.)
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IMPORTANT: If you are using OAuth Authentication for the first time, a dialog may display
requesting that you consent to granting permissions that the application needs to perform migrations.
To provide this consent, the account must be an Application Administrator. (This dialog will not
display if a Global Administrator has granted consent on behalf of the organization.)

Migrating to O365 Using SPO Containers
Metalogix Content Matrix supports the migration of Public Folders using shared SPO containers when
migrating to SharePoint Online. When you select this option, migration of large files (15 GB or more) is
supported for all source connection types. The Use SPO Container Office 365 Upload option is
enabled on the Configure Copy Options dialog- Site Options tab by default.
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Connecting with Certificates
When connecting to SharePoint, there are two options that can be used to add certificates to the list of
included certificates: Add Installed Certificate and Add Certificate From File.
SharePoint connections do not actually save the certificate information directly, but instead they save
the data on how to locate the certificates that are in use. This means that if the certificates are deleted
or moved from the referenced location, they will no longer be used with the SharePoint connection
and will have to be manually re-added.
SharePoint Certificates are also supported when generating a PowerShell script. It is still recommended
that the initial SharePoint connection is first configured in the Metalogix Content Matrix Console. The
recommended process when working with certificates and PowerShell is to first add the connection
(with certificates) in Metalogix Content Matrix, then set up a migration action in the UI and generate a
PowerShell script. This will allow you to get the connection format that is required to create a
connection in PowerShell, and it can then be written out manually (if desired).
It should also be noted that the Web Browser Authentication type does not automatically detect
certificates. In order for certificates to be included with this method, they must first be installed in the
appropriate locations in order for a web browser itself to access them.
NOTE: In some cases, including certificates can potentially result in receiving "maximum request
length" messages when migrating smaller files because the certificate information is included when
the data is being migrated.

To Add Installed Certificates:
Only "Personal" certificates can be added in this manner because it is the only store that web browsers
use to find certificates when accessing a website.
1. In the SharePoint Logon dialog, select the Include Certificates tab.
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2. Click [Add Installed Certificate].
The Add Installed Certificates dialog displays all of the certificates that are installed in the logged
in user account's "Personal" certificate store.
3. Select any certificates that should be included, and click [OK].
When you return to the SharePoint Logon dialog the selected certificates be displayed in the Included
Certificates list, and they will be included whenever Metalogix Content Matrix is running an action to or
from the SharePoint connection.

To Add a Certificate from a file:
1. In the SharePoint Logon dialog, select the Include Certificates tab.
2. Click [Add Certificate From File].
3. Either:
§

enter a filename and location into the Certificate File text box

OR
§

select the Browse button to open a file explorer dialog and navigate to, and select, the desired
certificate.

4. If a password is required to use with the certificate, enter it in the Password (optional) text box.
NOTE: When a connection to SharePoint is made, Metalogix Content Matrix will save the password
field for any certificates so it can re-establish a connection to that SharePoint instance at a later
date. If you are not comfortable with entering the password in the Password (optional) field, you
can move the certificate into the user account's "Personal" folder, and use the Add Installed
Certificate option instead, provided the user account/password is the same.
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When you return to the SharePoint Logon dialog, the selected certificate will display in the Included
Certificates list, and it will be included whenever Metalogix Content Matrix is running an action to or
from the SharePoint connection.

Important Note About Self-Signed Certificates
For security purposes, Content Matrix always attempts to validate a certificate when connecting to a
TLS/SSL site. Content Matrix cannot validate a self-signed certificate for an on-premises connection
however, and if it attempts to do so you will be unable to complete the connection. To avoid this
issue, you must change the value of the key BypassCertificateValidation in the
EnvironmentSettings.xml file to True.

Removing Certificates
Any certificates that have previously been added through the two Add Certificates options can also be
removed from the list of Included Certificates.

To remove a certificate:
1. In the SharePoint Logon dialog, select the Include Certificates tab.
2. Select the certificate(s) that you want to remove.
3. Click [Remove].

Connecting to SharePoint Using PowerShell
You can create and edit connections to SharePoint using PowerShell. These connections will display in
the Content Matrix Console.

To access the PowerShell cmdlets for connecting to SharePoint:
Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application
framework.
The following cmdlets are now available:
· Get-MLSharePointConnections
· New-MLSharePointConnection
· Set-MLSharePointConnection
· Remove-MLSharePointConnection
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To retrieve information about active connections in the Console:
Select (from the PowerShell ISE Command Window) or enter Get-MLSharePointConnections, then run
the cmdlet.
Details display for each active connection.

To create a new connection to SharePoint:
1. Select (from the PowerShell ISE Command Window) or enter New-MLSharePointConnection.
2. Select or enter the applicable parameters. Use the information in the following table for guidance.
Parameter

Notes

Address

The Url of the SharePoint object (Site, Farm, WebApp or Tenant) you
want to connect to.

(Required)
AuthenticationType

Valid values are:

(Required)

· Windows
· FormsBased
· Adfs

NOTE: Currently this cmdlet does not support connecting to
SharePoint Online with OAuth authentication.
· UserProvided

NOTE: UserProvided authentication is used to make site-level
connections to special types of tenants, such as GCC High. To use
this type of authentication, you must first run a utility provided by
Quest Support and enable the setting
EnableUserProvidedAuthentication. Refer to the Quest Support
Knowledge Base article Enabling User Provided Authentication in
Content Matrix for details.
ConnectionType

Valid values are:

(Required)

· Om (local object model)
· MEWS (remote connection using Metalogix Extension Web Service)
· CSOM (for SharePoint Online targets only)

TargetType

Valid values are:

(Required)

· Site
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Parameter

Notes
· WebApp
· Farm

ConnectAsCurrentUser

Use this parameter if you want to make a SharePoint on-premises
connection using the currently logged-in user.
NOTE: This parameter is not necessary when using an OM
connection, which automatically connects as the currently logged-in
user.

MewsVersion

This parameter is only necessary if you want to use an older version
of the Metalogix Extension Web Service.

Password

The password of the account making the connection.

RememberPassword

This option is recommended to to ensure that the connection
remains active after the PowerShell session has ended. If it is not
used, the password will have to be re-entered.

Readonly

Use this parameter if you want to make a read-only connection to a
SharePoint source.

SkipConnectionCheck

Use this parameter if you want to skip validation of the connection.
This is useful if you use a connections factory and speeds up the
creation of connections.

User

The user account making the connection.

3. Run the cmdlet.
Example Scripts:
New-MLSharePointConnection -Address http://win-pvf4cd21m55/ AuthenticationType Windows -ConnectionType MEWS -TargetType Site -Password
"Pass" -User Administrator -RememberPassword
New-MLSharePointConnection -Address https://metalogixsoftwareadmin.sharepoint.com -AuthenticationType Adfs -ConnectionType Csom TargetType Tenant -Password "Pass" -RememberPassword -User
cpqauser@metalogixsoftware.onmicrosoft.com

To edit a connection to SharePoint:
1. Select (from the PowerShell ISE Command Window) or enter Set-MLSharePointConnection.
2. Enter the ConnectionId.
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NOTE: You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.
You can now update any of the following parameters, then run the cmdlet:
· ConnectAsCurrentUser (on premises connections only)
· Password
· RememberPassword
· SkipConnectionCheck

NOTE: Use this parameter if you want to skip validation of the connection. This is useful if you use
a connections factory and speeds up the creation of connections.
· User

Example Script:
Set-MLSharePointConnection -ConnectionId '91335f9c-9311-439e-9b8e78d6f7ef480a' -Password pass -RememberPassword -User Administrator

To remove a SharePoint connection:
1. Select (from the PowerShell ISE Command Window) or enter Remove-MLSharePointConnection.
2. Enter the ConnectionId.
NOTE: You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.
You can remove multiple connections using the PowerShell pipeline variable.
3. Run the cmdlet.
Example Scripts:
Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA617EEDF583594'

Remove multiple connections using the PowerShell pipeline variable:
Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA617EEDF583594 ,'2F91B056-C300-4263-9FA6-17EEDF583594','2F91B056-C300-42639FA6-17EEDF583594' | Remove-MLSharePointConnection
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7
Preparing for Your Migration
Metalogix Content Matrix offers a number of tools to help you locate and organize data and in
preparation for your migration. You can:
· Create a target SharePoint hierarchy prior to migration
· Perform a pre-migration analysis
· Create SharePoint objects
· Delete SharePoint objects

Creating a Target Hierarchy
When migrating Public Folder content, there are two options for creating the target SharePoint
hierarchy. In Microsoft Exchange, it is possible to create Calendars, Contact and Task lists on any level.
They can be included in any of the existing folders. However, SharePoint does not support such
hierarchies, and lists can only be created under a SharePoint site. Metalogix Content Matrix tries to
create a corresponding structure in SharePoint that is as close as possible to the original Public Folder
hierarchy on Exchange, based on the available options (that have been configured to a users
preferences).
NOTE: Content Matrix supports target URLs for Public Folders migrated to SharePoint Online of up to
400 characters, which is the maximum length that SharePoint Online allows.

Flattened (Folder) Hierarchy
In choosing this option, simple Public Folders will be migrated as SharePoint document libraries for the
root level, using subfolders within the given document library. Customized SharePoint lists (Calendars,
Contact and Task lists) will be created on the root level. The name of the target library and lists will
contain the path to the MS Exchange list in the original structure, as shown below:
Migration Example 1
MS Exchange

MS SharePoint

Root\Folder 1\Subfolder 1\Test calendar

Root\Folder 1_Subfolder 1_Test calendar

Migration Example 2
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-> Migration using flattened
hierarchy model ->

Site Hierarchy
If you would like to retain the exact parent-child hierarchy in SharePoint that was originally in your
Exchange public folder hierarchy, choose Site Hierarchy Creation.
In this case:
· SharePoint Sites are created for every folder level in the original structure.
· On the corresponding site SharePoint Lists or libraries are created for every Exchange public folder:
§

Document libraries for every Mail and Post Items public folder.

§

Task lists for every Exchange Tasks public folder.

§

Calendars for every Exchange calendar public folder.
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§

Contact list for every Exchange contact public folder list.

§

Document libraries for any other type of Exchange public folder.

Items in the root folder in Exchange will be placed in a Document Library (or other list) named 'Items'.

Sample Migration Diagram

Migration Example 3
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-> Migration using site
hierarchy model ->

Splitting Large MS Exchange Public Folders
A source Exchange public folder can contain tens of thousands of items. Microsoft recommends not to
have more than 5000 items in a single SharePoint container (list or folder) as it can result in degraded
SharePoint performance. Metalogix Content Matrix can automatically split the contents of a large
Exchange Public Folders into multiple SharePoint subfolders. Setting the limit of how many items can be
migrated into one SharePoint container is an option on the Paste settings dialog under the Hierarchy
Options tab.
Each created subfolder name has its parent's name, plus and the 'Received' or Created date of the first
item appended to it, as shown below:
Original Exchange public folder name

SharePoint folder names
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Company items

Company items\<date 1>
Company items\<date 2>
Company items\<date 3>
...
Company items\<date n-1>
Company items\<date n>

Performing a Pre-Migration Analysis
You can use pre-migration analysis functionality to analyze all the data intended for migration. Premigration analysis will search for incompatibilities which can occur during the migration, and thus help
you optimize the migration process, identify the potential migration issues, and get an overview of the
content size and item count. It will also estimate the migration speed from the source environment
into the target environment, to help you plan the migration.

To run a pre-migration analysis:
1. In Explorer View, select the Exchange Connection node for which you want to run the analysis.
2. Right-click and choose Pre-migration analytics to display the Pre-migration analytics dialog.

3. Click Run analytics in the top left corner to open the Analytics settings dialog, to configure the
desired settings for the analysis action.
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4. Select the Target SharePoint node against which you want to run the analysis.
5. Configure the Migration settings options as follows:
a) If different from the default, specify the maximum number of items the analysis will calculate
to be in one container (folder or subsite depending on hierarchy type) by entering a enter a Split
containers after: value.
NOTE: If the number of items exceeds the defined limit, a new container will be "created" and
the analysis will continue.
b) For Hierarchy creation type, select whether you want Metalogix Content Matrix to:
§ "create" Subsites under the target for new hierarchy levels

OR
§ "create" Folders for new hierarchy levels.

c) For Output type, select the output format you want to use for analyzing items.
NOTE: The EML format is only possible using the EWS connection type.
d) If you want the creation of a new target site to be included in the analysis:
§ Check the Create site for migration box, and
§ specify a Site Name.

6. Specify the applicable Logging Settings Options:
a) If different than the default, specify a Stop analysis after "x" warnings/errors limit, which is
the number of warnings/errors that can occur within logs before the analysis will stop.
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b) Check the applicable Log the following: boxes. Use the information in the following table for
guidance.
If you want Metalogix Content Matrix to
...

Then ...

log critical errors

check the Critical errors preventing item
migration box.

log warnings

check the Migration Warnings box.

log folder/item renaming warnings

check the Folder Item renaming box.

log Exchange custom forms published into
public folders

check the Custom forms box.
This option is not supported for a
MAPI connection to Exchange Server
(all versions) or an EWS connection
to Exchange Server 2007.

calculate the size of files as well as the
average item size

Calculate the file size (will slow down the
analysis) box.
NOTE: This option is required if you want to
Estimate the migration speed and will slow
down the analysis

log files larger than a specified size

·

check the File size warning for files larger
than "x" box, and

·

if different than the default, specify the file
size (in MB).

7. Once all of the desired settings are selected in the Analytics settings dialog, click [OK] to continue.
The analysis will now run. The Pre-migration analytics dialog will show that it is running the analysis in
the bottom left-hand corner, and will list the number of log entries next to the analysis (at the bottom).
You can stop the pre-migration analysis by clicking the Stop button in the top right corner of the dialog.
When the analysis is complete the results will be populated in the items grid, Details section and
Summary section (these sections can be expanded by clicking the "up" arrow on the far right-hand side
of the dialog, on the same line as each title). Problematic items are displayed with a warning icon. In
these cases you can find more details in the Details section.
Expand the Summary section to read the summary information on content size, its count etc.
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To estimate migration speed:
NOTE: If you chose to Calculate the file size when configuring the pre-migration analysis, a
confirmation dialog displays after the analysis has run, prompting you to estimate the migration time
based on configured settings.
1. When prompted, click [Yes] to estimate the migration time.

2. Select the source Public Folder for which you want to estimate migration speed.
This window includes only Public Folders that exist under the Public Folder connection originally
selected for the pre-migration analysis. It is recommended that users select a folder that contains
at least 500 items, but any folder can be selected.
3. Click [Next].
4. Select the target SharePoint node.
5. Click [Next] to Estimate migration speed dialog

6.

Click [Start] to begin the estimate.
When the speed estimate runs, results are displayed, in progress, in the window. The progress bar
displays the analysis percentage that is complete.

7. When the process finishes, click [OK]. Users can see the estimated migration speed in the final
dialog.
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If you return to the Pre-migration analysis dialog, you can expand the Summary section, you can
view pre-migration analysis results with an estimated time to complete migration of the public
folder.

Creating a SharePoint Object
You can create new SharePoint site collections, sites, folders, and lists via the Metalogix Content
Matrix Console.

Creating a SharePoint Site
You can create a new SharePoint site via Metalogix Content Matrix under an existing site collection or
site except for Database connections and the new site can use any site template that is installed on the
SharePoint environment.

To create a new SharePoint site:
1. In the Explorer View, select the site collection or site under which you want to create the new site.
2. Right-click and choose Create Site.
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The Create Site dialog displays, prompting you to enter the Site Title, Site URL Name, Description,
and Template for the new site.
NOTE: For Site URL Name, it is only necessary to enter the name of the site as you want it to
appear in the URL, not the entire URL path.

Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is
(modern) Team Site (no Office 365 group). For SharePoint Online, Content Matrix does not
support connections to tenant-level groups.
3. When you have completed the fields on the Create Site dialog, click [OK].
The new site will now display in Explorer View.

Create SharePoint Site Collection
You can create a new site collections on a target SharePoint environment for any SharePoint
connection type, except for database and site connections.

To create a new SharePoint site collection:
1. In the Explorer View navigate to the SharePoint Farm/ Web Application (on premises) or Tenant
(SharePoint Online) where the new site collection should be created.
2. Right-click and choose Create Site Collection.
3. Complete the fields on the Create Site Collection dialog for the selected Mode as you would if you
were creating a site collection from within SharePoint.
NOTE: In addition, you have the option to create a host named site collection using the Host
Header option. Refer to the Microsoft TechNet article details about host-named site collections.
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Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is
(modern) Team Site (no Office 365 group) (STS#3). For SharePoint Online, Content Matrix does
not support connections to tenant-level groups.
4. After completing the dialog, click [OK].
The new site collection now displays in the Explorer View.

Create a SharePoint List
You can create a new SharePoint list via Metalogix Content Matrix under an existing site as long as:
·

the connection type is not read-only, and

·

the new list can use any site template that is installed on the SharePoint environment.

If site creation is not valid for the connection type, the option will be disabled.

To create a new list:
1. Navigate to the SharePoint Site where the list/library should be created.
2. Right-click and choose Create List.
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3. Complete the Create List dialog as you would if you were creating a list from within SharePoint.

4. After completing the dialog, click [OK].
The new site collection now displays in Explorer View.

Create SharePoint Folder
You can create a new SharePoint list via Metalogix Content Matrix under an existing list or library (or
within an existing folder) as long as the connection type is not read-only.. If folder creation is not valid
for the connection type, the option will be disabled.

To create a new SharePoint folder:
1. Navigate to the SharePoint Document Library, List, or Document Folder under which the new folder
should be created.
2. Right-click and choose Create Folder.
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3. Complete the Create Folder dialog.
Note that the Folder Type drop down allows you to select the content type with which to create
the folder. if only one content type exists on that list/library/folder, the option will be grayed out.
There is also a check-box option to overwrite any existing folder that uses the same folder name at
the level the folder is being added.

4. After completing the dialog, click [OK].
The new folder now displays in Explorer View.

Deleting SharePoint Objects
You can delete one or more SharePoint objects via Content Matrix as long as the connection type is
not read-only. SharePoint objects that can be deleted via Content Matrix are:
·

SharePoint Sites

·

SharePoint Lists

·

SharePoint Document Folders
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·

SharePoint Documents

·

SharePoint List Items

If the action is not valid for the connection type, it will be disabled.
NOTE: Document versions and list item versions cannot be deleted via Content Matrix.

To delete one or more SharePoint Objects:
WARNING: When this action is used at the site level or below, the object will be deleted permanently
(i.e., it will not be sent to the Recycle Bin). However, a pop-up dialog will display that allows you to
cancel the action.
1. Select the SharePoint object(s) to be deleted.
NOTE: Depending on the type of object, this may be in the Explorer View or in the Items View.
2. Either:
§

Press the Delete key on the keyboard.

§

Right-click on the object and choose Delete [Object].

You will be prompted to confirm the action before continuing.
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8
Initiating a Migration
From the Metalogix Content Matrix Explorer View, you can "copy" an object from the source
connection then "paste" it to the appropriate location on the target connection. You will then be
prompted to configure Copy Options.

You can migrate one or more Exchange folders or individual Exchange items, or migrate Exchange
emails directly into a SharePoint Online document library.

Migrating Exchange Folders
You can use Metalogix Content Matrix to migrate Exchange Public Folders to SharePoint. You can
migrate entire public folder hierarchies or all items within folders and subfolders.
Some restrictions apply when migrating, Exchange content to SharePoint. For example, calendar items
can only be migrated to SharePoint calendars, etc.

To initiate an Exchange Folder migration:
1. In Explorer View, select the Exchange folder(s) you want to migrate.
NOTE: Multi-selection is possible as long as you select nodes at the same level.
2. Right-click and choose Copy Exchange Folder.
3. Select the SharePoint node(s) to which you want to paste the content.
NOTE: You can migrate to multiple SharePoint target locations. Right-click the target node and
select the option. In case you do not want to create a new SharePoint container, you can migrate
all items from an MS Exchange Public Folder to an already existing SharePoint list or folder, by
selecting the option.
4. Select the appropriate Paste option. Use the information in the following table for guidance.
If ...

Right-click and choose ...

you want Metalogix Content Matrix to create
a new target SharePoint container as part of
the migration

Paste Exchange Folder To List.
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If ...

Right-click and choose ...

you want to migrate the Exchange Folder(s) to
an existing SharePoint list or folder

Paste All Exchange Folder Items.
NOTE: This action will migrate all items inside
the source folder and all of its subfolders.

Continue with Configuring Copying Options

Migrating Individual Exchange Items
You can migrate individual Exchange Public Folder items into an existing SharePoint folder.
Some restrictions apply when migrating, Exchange content to SharePoint. For example, calendar items
can only be migrated to SharePoint calendars, etc.

To migrate individual Exchange items:
1. In Explorer View, select Exchange folder containing the items you want to migrate.
2. Switch to Items View.
3. Select the Exchange item(s) you want to migrate.
4. Right-click and choose Copy Exchange Item.
5. Select the target SharePoint target list or folder.
6. Right-click and choose Paste Exchange Items.
Continue with Configuring Copying Options.

Migrating Emails Directly into a SharePoint
Online Document Library
You can migrate Exchange emails directly into a document library that has been created either in
SharePoint Online or in the Content Matrix Console.
NOTE: This option is not available when migrating to SharePoint on premises.
Before you can choose a Paste operation, Content Matrix must first add the following Exchange
Columns to the library:
· From
· Subject
· Received
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· Item Class
· To
· CC
· BCC
· ReplyTo

To migrate Emails directly into a SharePoint Online Document
Library:
1. Select the email folder or individual email items you want to migrate.
2. Right-click and choose the appropriate option (Copy Exchange Folder or Copy Exchange Item).
3. Select the target document library.
4. Right-click and choose Add Exchange Columns.
5. When Content Matrix has finished adding the columns to the library, right-click and choose the
appropriate option (Paste Exchange Folder or Paste Exchange Item).
Continue with Configuring Copying Options.
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9
Configuring Copying Options
The Paste [Object] dialog provides a tabbed interface that enables you to configure a migration
according to your specifications. Available tabs will vary based on the type of migration that you
initiated.

Hierarchy Options
You can migrate your source Exchange Public Folder hierarchy to the target SharePoint environment as
part of a basic migration. You can also create a sub-site/sub-folder hierarchy based on the number of
items in each Public Folder "container."
NOTE: Content Matrix supports target URLs for Public Folders migrated to SharePoint Online of up to
400 characters, which is the maximum length that SharePoint Online allows.
See Creating a Target Hierarchy for more details.

To configure Hierarchy Options:
1. Chose the appropriate Hierarchy creation type; that is, whether you want Metalogix Content
Matrix to create the folder hierarchy under the target SharePoint node as:
§

Subsites

OR
§

Folders

2. For Split containers after:, specify the maximum number of items to be migrated into one
container (a document library, folder, etc.).
NOTE: If the number of items in the source container exceeds the number specified, Metalogix
Content Matrix will create a new container at the same level.
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Site Options
If you are migrating folders into a site, use the Site Options tab to specify how you want a newly
created site to be configured.
NOTE: This tab will not display if you are migrating emails directly into a SharePoint Online document
library.

To configure Site Options:

1. Check the Create site for migration box to have a new site created under the selected target
SharePoint node.
2. For Site name, enter the display name text as the display name that you want to use for the newly
created SharePoint site.
3. If you want the newly created site to be included in the navigation settings of the parent
SharePoint site, check the Show site in parent navigation box.
4. Select an available Site template for the new site from the drop-down.
5. If you want the SharePoint site to use the tree view setting in the quick launch navigation (lefthand navigation) for the new site, make sure the Enable tree view on sites box is checked.
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6. If you have connected to a SharePoint Online site and want to migrate using SPO Containers, make
sure the Use SPO Container Office 365 Upload box is checked.
NOTE: If you are migrating to a SharePoint on premises environment, this box will be disabled.

Users and Permissions Options
Users And Permissions Options enable you to map Exchange user accounts and permissions (such as
Author, Reviewing Author, etc.) to SharePoint user accounts and permissions (such as Full Control,
Contribute, Read, etc.).. This means that an Exchange user account can be mapped into a SharePoint
user account.
IMPORTANT: Users from the source can only be mapped to the SharePoint target if there is some kind
of shared authentication method (such as Active Directory) between them.
If no mappings are specified for any user based metadata that is migrated, Metalogix Content Matrix
will use the migrating user account for this metadata instead.

To configure User and Permissions Options:

1. Click [Set user mappings...] to display the User Mapping dialog, and follow the procedure for
Mapping Users and Permissions.
2. If you want to copy user permissions:
a) Check the Copy permissions box.
b) If you want to explicitly map permissions between source and target, click [Set permissions
mapping] and follow the procedure for Mapping Users and Permissions.
NOTE: If you choose not to map permissions, Metalogix Content Matrix will be use Automatic
Permissions Mapping.
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c) If you want any permissions that are not explicitly mapped to be skipped, check the Skip nonmapped permissions box.
NOTE: If this box is not checked, Metalogix Content Matrix will be use Automatic Permissions
Mapping for permissions that are not explicitly mapped.

Mapping Users and Permissions
You can explicity map users and permissions when you click the [Edit Users] or [Edit Permissions]
button from the Users and Permissions tab.
NOTE: If the source environment has a large number of users, it is recommended that the XML user
mapping method be used instead, to help improve performance, and for better control over user
mapping.

To map user and permissions:

1. Use the information in the following table to determine the appropriate action to take.
NOTE: You can Filter items in each window to narrow displayed lists.
If ...

Then...

you want to load mappings from a

click the Load icon.
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If ...

Then...

previously-saved xml file
you want to manually map individual users
or permissions on the source to a target
SharePoint user or permission

·

From the source list, select the Item that you
want to map.

·

From the target list, select a target Item.

·

Click the Map icon.

· From the User Mappings dialog - source list,
you are mapping users and want to have
select the Item(s) that you want to map.
Metalogix Content Matrix automatically map
source users to target SharePoint users
· Click the Auto icon.
(based on email address)
NOTES:
· The Exchange From field will be mapped to

the SharePoint Created by field.
· The Exchange Last modified by user field will

be mapped to the SharePoint Modified by
field.
· If a user has already been mapped during a

migration, the SharePoint Created and Last
Modified fields are maintained on the target.
save mappings in the dialog as an xml file

click the Save icon.

The mappings you create will display in the bottom window. (Note that you can also Unmap
individually-selected mappings in the bottom window or or Clear all mappings from the bottom
window.
2. Click [OK] to return to the Copy Options dialog.

Importing Mappings from an xml File
Metalogix Content Matrix can import any desired user or permissions mappings from an XML file.
Importing user or permissions mappings from an XML file involves creating an XML file with the desired
mappings, then importing that file. This option is generally used if migrating from an environment that
has a large number of users and/or permissions

Example Permission mapping XML
<?xml version="1.0" encoding="utf-8"?>
<StaticMaps>
<Map ExPermission="Owner" SpPermission="Full Control" />
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<Map ExPermission="NoneditingAuthor" SpPermission="Read" />
</StaticMaps>

There could be more Mapped sections within the root StaticMaps section of the XML file. Each Map
section defines mapping for Exchange permission into SharePoint permission.
ExPermission - Exchange permission (mandatory)
SpPermission - SharePoint permission (mandatory)

Example User mapping XML
<?xml version="1.0" encoding="utf-8"?>
<StaticMaps>
<Map ExUser="adm@tests.local" SpUserDisplayName="adm"
SpUserEmail="adm@tests.local" SpUserIsGroup="False"
SpUserLoginName="TESTS\adm" />
<Map ExUser="test02@tests.local" SpUserDisplayName="test02"
SpUserEmail="test02@tests.local" SpUserIsGroup="False"
SpUserLoginName="TESTS\test02" />
<Map ExUser="test03@tests.local" SpUserDisplayName="test03"
SpUserEmail="test03@tests.local" SpUserIsGroup="False"
SpUserLoginName="TESTS\test03" />
<Map ExUser="test05@tests.local" SpUserDisplayName="test05"
SpUserEmail="test05@tests.local" SpUserIsGroup="False"
SpUserLoginName="TESTS\test05" />
</StaticMaps>

There could be more Map sections within the root StaticMaps section of this XML. Each Map section
defines mapping of Exchange user (or distribution list) into SharePoint user (or group).
·

ExUser - Exchange user or distribution list email address (mandatory).

·

SpUserDisplayName - SharePoint user display name (optional).

·

SpUserEmail - SharePoint user email address (optional).

·

SpUserIsGroup - group flag whether SharePoint user is a group (optional, default value set to
"False").

·

SpUserLoginName - SharePoint user login name or the group name in case of group (mandatory).

Automatic Permissions Mapping
When you Configure Users and Permissions Options, you can either map user permissions explicitly, or
have Metalogix Content Matrix map permissions automatically, as specified in the following table.
NOTE: Custom permission groups will be created in SharePoint.
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Filter Options
Filters can be applied to the migrating content to help limit the content that is migrated. Metalogix
Content Matrix Console uses inclusive filters, meaning that any criteria that meets the set filter will be
included in the migration. You can apply multiple filters to a single migration action, and the order in
which these filters are applied and be modified.
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To configure Filter Options:
1. If you want to apply a filter to the migration, click [New Filter] to display the Select Filter dialog.
2. Select the type of filter you want to apply.
A new dialog displays based on the filter type you selected.
3. Enter the filter criteria that you want to apply to the migration.
4. To apply another filter, repeat steps 1-3.
Note that you can use the up and down arrows (
be applied.

) to change the order in which the filters will
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General Options
Use the General Options tab to configure additional options such as logging, item output type, fields to
migrate, and column mappings.

To configure General Options:

1. If you want more detailed logging for the migration action, make sure the Enable verbose logging
box is checked.
2. If you want to overwrite any any existing items that have been migrated to the same target
location with the same connection adapter type, check the Overwrite existing items box.
3. If you want to allow all day events to remain as all day events in SharePoint after the migration,
make sure the Keep all day events box is checked.
NOTE: If this box is not checked, all day events will be converted to standard (not all day) events
with a duration of 24 hours. This conversion is mainly useful if the migration is between systems
using different time zones.
4. Select the desired Output type. Use the information in the following table for guidance.
NOTE: Exchange folders can be pasted to a SharePoint list or folder only if that list or folder was
created by Metalogix Content Matrix Some restrictions apply when migrating; for example,
calendar items can only be migrated to SharePoint calendars, and so on
If you want to migrate
items ...

Then ...

in electronic mail (EML)
format

select EML.
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If you want to migrate
items ...

Then ...

NOTE: Items migrated in this format do not retain all original
MAPI properties of the source Exchange item.
in message object (MSG)
format

select MSG.
NOTES:
· Items migrated in this format to SharePoint open automatically

with Outlook, and the email body, header, and any attachments
are fully preserved and maintained within a single envelope in
one file on SharePoint.
· MSG is supported by MAPI, Redemption, and PST connecti9ons,

but not by an EWS connection.
5. To select the fields to migrate to the SharePoint target:
a) Click [Select fields to migrate] to display the Select Fields to Migrate dialog.

NOTE: In MS Exchange, every item has dozens of properties which can be read and potentially
migrated to SharePoint. Most of these properties have little meaning for end users, and are not
particularly useful in a SharePoint environment, however, users may want to retain them for
historical or audit purposes. Metalogix Content Matrix Console offers a default set of
properties that will automatically be migrated for every list type.
b) Select additional fields to be created and migrated to the target SharePoint site and/or
removed from the list.
EXCEPTIONS: The following properties cannot be removed because they are needed for
identifying migrated items:
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· OutlookID - A unique item identifier field that is typically not visible to the end

user, in the default SharePoint list or library view.
· Subject - A string field that lists the item's subject (i.e. mail subject, document

name, calendar item title, etc.)
c) If you want to apply Content Types to the target list, click [Apply Content Types] to display the
Content Type Application Options dialog and follow the procedure for Applying Content Types
to Lists and Libraries.
NOTE: This button is available for each list type (Document Library, Task, Contact, Calendar,
etc.). Settings defined for one list type do not affect other list types. The content types
specified in the pop-up dialog will be applied to the target list and it will be possible to create
items based on this content type in SharePoint (see further).
6. If you want to map source to target columns, click [Column Mappings] to display the Edit Column
Mappings dialog and follow the procedure for Mapping Columns.

Mapping Columns
You can map columns from the source connection into separate columns on the target when migrating
content into a SharePoint target.
NOTE: Metalogix Content Matrix allows one-to-one column mappings. If a source or target column
is already used in a mapping, then that column will no longer be available for any other mappings.
The following types of column mappings can be made:
·

Standard column mapping, when you click [Column Mapping] from the General Options tab

·

Content Type column mapping, when you click the [...] button from the Content Types Application
Options dialog.

To map columns:
1. Use the information in the following table to determine the appropriate action to take.
NOTE: You can Filter items in each window to narrow displayed lists.
If you want to ...

Then...

manually map each individual source
column to a target SharePoint column

·

From the left (source) window, select the Item
that you want to map.

·

From the right (target) window, select an
available Item.

·

Click the Map icon.

·

From the left (source) window, select the Item
that you want to map.

create a new column on the target for any
columns that are selected on the source
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If you want to ...

Then...

side

·

Click the Target icon to display the New
Mapping Target dialog.

·

Enter a Column Name.

·

If you want the column to be created as a site
column, check the Create as Site Column, , and
choose a column type from the Group dropdown.

·

If you want to add the column to a content
type that exists on the target:
§

check the Add to content type scoped at
target site box
AND

§

select the content type to which you want
to add the column from the Type drop
down.

The mappings you create will display in the bottom window. (Note that you can also Unmap
individually-selected mappings in the bottom window or Clear all mappings from the bottom
window.)
2. Click [OK] once all desired mappings have been made and return to the Configuration Options
dialog.

Mapping Items to Content Types
You can specify content types for target items when you click the [...] button from the Content Type
Application Options dialog.

To map items to content types:
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1. Select the content type, and click [Edit Conditions] to display the List Items and Documents Where
filter dialog.
2. Select the filter(s) you want to apply as you would when applying filters to a migration.
NOTE: If you select [Clear Condition], all conditions that are currently applied to that content type
will be cleared.
3. Once all filters have been set, click [OK] to return to the Content Type Application Options dialog.

Applying Content Types to Lists and Libraries
You can specify content types for the target list when you click [Apply Content Types] from the
General Options - Select Fields to Migrate dialog.

The left-hand window (Content types on target site ) displays all of the available content types that
exist on the target SharePoint instance that can be applied to the target list. The right-hand window
(Content types to apply) displays all of the selected content types that will be applied to the list.

To apply content types to lists and libraries:
1. From the Content types on target site window, select all of the content types that you want to
apply to the list and move them to the Content types to apply window.
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2. Select any of the remaining options that you want to apply. Use the information in the following
table for guidance.
If you want to ...

Then ...

map a content type
column on the source to a
column on the target, as
the new content type
column

A. Check the Map source data to new content type columns box.
B. Click the [...] button to display the Edit Column Mappings
dialog.
.]

C. Continue with the procedure for Mapping Columns.

map items from the source A. Check the Map source data to new content type columns box.
into a new content type on B. Click the [...] button to display the Map Items to Content Types
the target based one or
dialog.
more specified filters
C. Continue with the procedure for Mapping Items to Content
Types.
NOTE: This option is available only when migrating Exchange
folders (not individual items).
change the default content A. Check the Change default content type box
type for the target list or B. Select a content type from the drop-down.
library
NOTE: When you check this box, the Add unmapped items to the
default content type is automatically enabled and checked.

Transformations Options

You can view, create, and edit Transformers which, as the name implies, "transform" content during
migration.
There are several built-in, non-editable transformers that Metalogix Content Matrix uses to process
data during the migration. Advanced users can also create custom transformers using PowerShell.
The Transformations tab consists of two main sections: Available Definitions and Applied
Transformers For <Object>. The Available Definitions section will list all of the transformation
definitions that are available for the current migration action, in alphabetical order. For example, the
Site definition is available when migrating at the site level or higher. However, if migrating as a
document library or migrating documents, this definition will not be listed.
When one of the Available Definitions items is selected, any transformations that exist/have been
configured within the migrating content will appear. Some of the actions that may be grayed out.
These grayed out items are mandatory transformations that are run during the course of a normal
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migration, and these actions cannot be edited or removed. However, they can be reordered by using
the up and down arrows to the right-hand side of the window if you want a transformation action to
occur before a mandatory action. Actions that appear and are not grayed are user added
transformations, and can be moved, edited and deleted at the users discretion.
In some cases, you could add another instance of an existing transformer, and then have it run in two
different locations within the migration process. One could be run in the middle, and it could be run
again just before the end.

Using PowerShell to Create Custom Transformations
When you select the Add Transformer > Invoke PowerShell script option for an Available Definition,
you can use custom PowerShell scripts to create your own transformations beyond the built-in
capabilities of the Metalogix Content Matrix.
Specify when you want the script to run by selecting one of the following options:
Begin Transformation – The transformation script will run before the migration of the affected
objects, allowing you to read and make changes to objects on the source before objects themselves
migrate.
Transform – The transformation script will run while the migration of the affected object(s) is in
progress. For example, the user mapping between source and target would be run using the Transform
option.
End Transformation – The transformation script will run after the migration of affected object(s),
allowing you to read and make changes to objects on the target.
EXAMPLE: The following Transformer consists of two scripts for disabling and re-enabling the
Required setting for a column list.
·

The first script entered into the Begin Transformation tab sets the setting of any columns that are
Required to false before copying begins.
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·

The second script, entered into the End Transformations tab, sets the setting back to true after
item migration has completed.
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10
Saving or Running a Migration
Action
When you finish configuring a migration action, you can run it immediately or save a copy of the
settings to a job file, which displays in the Job List section. You can then:
·

run a migration directly from the Job List section

OR
·

create a PowerShell script and schedule it to run as a Windows Scheduled Task

OR
·

trigger jobs in the Content Matrix Console to run using PowerShell.

You can also save the job configuration as a template so that you can preserve and reuse settings for
future migration jobs.
When the migration starts, a status dialog box will appear. The job logs can be viewed (in progress or
after the migration is finished) by clicking [Details>>]. The Status section of the status box will list a live
count for the number of successes, warnings, failures, etc. for the migration. The Progress section of
this dialog will list any completions and the type of completion (Sites, lists, items, users, groups, etc.). A
Migration Completed message will appear when finished. Click Close to exit the status dialog.
IMPORTANT: As of version 9.2, Distributed Migration has been removed from Content Matrix Public
FolderEdition, and you will no longer have the option to Run Remotely.

Connecting to a Full SQL Job Database
If you are using SQL CE to host your Content Matrix Jobs Database, you will receive a warning in the job
log (and as a pop-up if you are running the job from the Console interface).
The use of SQL CE in a production environment is discouraged because of the following limitations:
·

It uses a single .list file that is less robust and reliable and may be corrupted after the database
reaches 4 GB.

·

Data compression is not supported.

·

Support for large objects is limited.
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To switch to a full-feature SQL Server for the Content Matrix Job
Database:
1. From the Job List choose File > Connect to Job Database.

2. Complete the Connect to SQL Server dialog:
§ If you are connecting to an on premises SQL database, create (using the New Database option)

or select the database you want to use.

§ If you are connecting to an Azure SQL database, select the database that has been created in

Azure Portal for use by Content Matrix. (Note that the New Database and Delete Database
options will be disabled.)
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3. If you want to use an encrypted connection to the database, check the Encrypt Connection box.
NOTE: If the certificate used for encryption is not trusted, you will also need to check the Trust
Server Certificate box.
4. Select an Authentication method for connecting to SQL server.:
· Use Current Windows User

OR
· Use SQL Server Login

NOTE: Currently, Use SQL Server login is the only valid option for an Azure SQL server.
5. Click [OK].

Saving a Job Configuration as a Template
You can create job configuration templates for a set of selected settings which can be saved and
reused, including any options that are not normally preserved using the Preserve Configuration
Options option (in the ribbon Settings menu).
These templates can also be moved to another machine and used with a separate install of Metalogix
Content Matrix Console (provided that it is the same Edition of Metalogix Content Matrix, and the
same version number or greater).

To save a job configuration template:
1. After initiating a migration, complete the Configure (Object) Copying Options with the settings that
you want to include in the template.

2. Click [Save Job Configuration].
Here you can set the display name for the job template. This is not the actual file name, but it is
the name that Metalogix Content Matrix will use to list the template.
NOTE: In most cases, when a job template is saved by Metalogix Content Matrix it will be saved
to the following location:
C::\Users\<User>\AppData\Roaming\Metalogix\Metalogix Content Matrix Console - <Product>
Edition
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However, it is highly recommended that you do not interact with this system location. If you are
trying to save a job template so it can be exported to another system the template can be exported
from the Manage Job Configurations dialog.
3. Enter the desired display name value and click [OK] to continue.
Once the save is complete, you will be returned to the Configure <Object> Copying Options dialog
where the migration can either be Run or Saved.
The saved job templates will now be visible in the Manage Job Configurations dialog.
NOTE: If you are looking to save a job template and move it to another system for use, this should be
done using the Export option in the Manage Job Configurations window. Additionally, if you are trying
to Import a job template from another system, this must also be done from either the Manage Job
Configurations dialog or it can be imported when applying a template.

Applying a Job Template
Any job templates that have been imported or saved, and are available in the Manage Job
Configurations dialog can be applied to another migration of the same type. For example, if migrating
at the site level, you would not be able to use a job template that is created for a migration at the list
level. It would only be able to use a template that migrates at the site level.
The source and target connection types do not apply directly to a job template, so it does not matter if
the connection types for the new migration are the same as the connection types for the job template.
If the connection types are different than any options that are not applicable for the connection types
that are being used will not be available, but all other options will be set.
1. After initiating a migration, click [Open Existing Job Configuration] in the bottom left corner of the
Configure <Object> Copying Options dialog to display the Select Job Configuration to Apply
dialog.
NOTE: Any options you have specified directly in the dialog will be overwritten once a job template
is applied.
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The dialog lists all of the job templates that are currently available for the migration type (i.e. a
site, list, item, etc. migration), as well as only the templates for the specific Edition of Metalogix
Content Matrix that is being used.
2. Select the desired job template and click [OK].
You will be prompted to confirm your action before continuing. Remember that if you choose to
apply the template, any other settings that you entered directly in the Configure <Object> Copying
Options will be lost.
The Configure <Object> Copying Options dialog will now reflect all of the template options. Any
additional configuration options can be set or modified, and the migration can continue as normal.

Managing Job Templates
Metalogix Content Matrix Console job templates can be managed in the Manage Job Configurations
dialog. This dialog allows users to Import, Export, Delete, or Filter any job templates. Below is a
breakdown of the available options in the Manage Job Configurations dialog.
·

Import - This button allows users to Import a job template. The imported job template must be
from the same Edition of Metalogix Content Matrix Console. For example, if users are importing a
template into SharePoint Edition then the template must have been exported from SharePoint
Edition.

·

Export - This button allows users to Export a job template. The export will create an XML file in a
desired folder location so the file can be copied and placed into another location as needed.

·

Delete - This button will delete any selected job templates from Metalogix Content Matrix
Console. When deleting a template, a confirmation dialog will open and must be confirmed before
the templates are deleted. Deleting will permanently delete the selected templates from
Metalogix Content Matrix Console.

Metalogix® Content Matrix Public Folder Edition
Saving or Running a Migration Action

93

·

Filter - This is a text box that allow users to enter a value that Metalogix Content Matrix will filter
the job templates against. The filter will only display items that contain the specified value. There is
a Filter icon to the right-hand side of the filter text box. Clicking this icon will apply the filter text
value to all of the job templates listed in the Manage Job Configurations dialog, so only the
templates that contain/include the matching filter value will be shown. Filtering can be cleared by
removing the text value from the filter text box, and clicking the filter icon button.

Exporting a Job Template
To export a job template:
1. In Metalogix Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job
Configurations] button to display the Manage Job Configurations dialog.

2. Select the template you want to export then click the Export button at the top of the Manage Job
Configurations dialog, .
3. Navigate to the desired folder location where you want to save the job template, enter a File
name, and click [Save].
4. The job template XML file will be saved to the selected folder location, and Metalogix Content
Matrix will return to the Manage Job Configurations dialog. Any additional importing, exporting, or
deleting of job templates can be done. Click Close to return to the main Metalogix Content Matrix
window.
Now that the job templates have been exported and saved to a folder location they can be manually
moved to another location as required.
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Importing a Job Template
Only templates that have been created from the same Edition of Metalogix Content Matrix Console
can be imported. For example, a job template from SharePoint Edition cannot be used in eRoom
Edition or Public Folder Edition, it can only be imported into SharePoint Edition.

To import a job template:
1. In Metalogix Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job
Configurations] button to display the Manage Job Configurations dialog.

2. Click the Import button at the top of the Manage Job Configurations dialog, navigate to the folder
location for the template XML file, then click [Open].
The job template will be added to the list of templates in the Manage Job Configurations dialog.
The template will be listed using the same Display name that was used when the task was created
on the original system, and will not have its file name displayed.
The job template is now imported and can be applied to any migration.
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Importing and Exporting Migration Jobs
From the Job List, you can export a job to an xml file. This functionality allows you to:
·

Copy a job from one instance of Metalogix Content Matrix to another (as long they are for the
same Edition).

·

Manually modify a job, then re-import it.

To export a job to an xml file:
1. In the Job List, select the job you want to export.
2. Right-click, and choose Export selected job to xml.
The xml file will automatically open in whatever program is set as the default application for xml
files, and it can be saved to any desired location.

To import an xml file to the Job List:
1. Make sure the file you want to import uses a different ID value than any existing Jobs (this should
only be an issue if the XML file was previously exported from the same Metalogix Content Matrix
Console).
NOTE: If the xml file that is being imported contains the same ID value as an already existing Job,
then the import will fail.
2. From the Job List menu, choose File > Import Jobs From Xml.
3. Select the xml file to import.
If the import is successful, the job will be listed in the Job List section. If unsuccessful, an error
message will be given.

Refreshing the Jobs List
NOTE: The refresh is applied to whichever job list Metalogix Content Matrix is currently connected
to.

To refresh the Job List:
1. From the Manage Queue dialog, select a job in the Job List. The row selector icon and the
highlighted row indicates the selected row.
2. From the Job List menu bar, choose File > Refresh.
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If the status of the job has changed, the Status value will indicate the new status of the job.

Creating and Running a PowerShell Script from
the Jobs List
In order to create a PowerShell (PS) script for Content Matrix, a job list (or batch file) must first exist in
the Job List section of the Content Matrix Console. Once created, it can be run from the PowerShell
console or scheduled to run as a Windows Scheduled task.
NOTE: It is recommended that the connections to the source and target environments have the
Remember my password check-box selected. This is to ensure that the PowerShell scripts will be
able to establish a connection to both the source and target environments when they are being run. If
a password is required and this check-box is not set, the migration will fail. However, users can
manually enter this value into the PowerShell script itself if the option was not checked when the
script was first generated.

To create a PowerShell script:
1. In Job List, and select the job (or jobs) that you want to run in PowerShell.
2. Click the Generate PowerShell Script button in the Job List tool bar, or right-click on one of the
items and select Generate PowerShell Script from the context menu.
3. From the drop-down, choose the appropriate option. Use the information in the following table for
guidance.

If you want to generate a PowerShell script Choose …
for scheduling …
that can be used only by the currently logged For Current User and Machine.
in User Account on the machine it is
NOTE: Any PowerShell scripts that are generated
generated on
for scheduling through this option can only be run
by the logged in user on the machine they were
generated on.
that can be used by any User account on the For Local Machine.
machine it is generated on
that can be used by any User account on any For Certificate.
machine that has the certificate that is
When you save the PowerShell script using this
specified when the script is created
method you will be prompted to select a security
certificate that exist on that machine. The
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If you want to generate a PowerShell script Choose …
for scheduling …
selected certificate will be required on any system
that attempts to run the script at a later date.

Once the PS script generation type is selected, Content Matrix Console will generate a PS script for
the select Job, which will be written to a Microsoft Notepad file. If multiple jobs are selected they
will all be written to the same file.
4. Choose File > Save As... and select any desired save location for the PowerShell script. Give the file
any name you want, but change the file type to .PS1.

The PowerShell (PS) script itself contains five sections. They are:
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· Section 1 - This first section at the top (starting with an "if" statement) runs a check in the PowerShell

console to make sure that the Metalogix snap-ins have been added. If they are not found then it will
add them to that instance of the PS console.
· Section 2 - Load Configuration settings - This section will find and load all of the Metalogix Content

Matrix client application configuration settings into the PowerShell script. These are the client
application's environmental settings and not the migration/action settings.
· Section 3 - Load source - This section will load all of the data for the source environment

connection.
· Section 4 - Load target - Similar to the previous section, this will load target environment's

connection information.
· Section 5 - Run the action - Last is the "Run the action" section. This last section will contain all of

the other data for the migration, such as the type of migration (i.e. a site migration, list migration,
item migration, etc.) and all of the settings and configurations for the migration/action that is being
run. This includes things like settings for versions, content types, permissions, etc.
Now you can run or schedule the PowerShell script.

Running a PowerShell Script
Once a PowerShell script has been created, you can run it from the PowerShell console.

To run the PowerShell script:
NOTES:
· If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.
· If Content Matrix settings is changed, in order to apply new settings all PowerShell sessions must be

restarted.

To add the PowerShell cmdlets for the application framework:
1. Open a Powershell ISE or PowerShell console session.
2. Add the PowerShell snap-ins by pasting in the following text:
if ( $PsVersionTable.PSVersion.Major -lt 3 ) { Write-Host "Windows
PowerShell Version 3.0 or later needs to be installed in order to run
Content Matrix PowerShell scripts."; exit; }
if ( (Get-PSSnapin -Name Metalogix.System.Commands -ErrorAction
SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.System.Commands |
out-null }
if ( (Get-PSSnapin -Name Metalogix.Exchange.Commands -ErrorAction
SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.Exchange.Commands
| out-null }
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if ( (Get-PSSnapin -Name Metalogix.SharePoint.Commands -ErrorAction
SilentlyContinue) -eq $null ) { add-pssnapin
Metalogix.SharePoint.Commands | out-null }if (Get-Command SetMetalogixJobPrerequisites -ErrorAction SilentlyContinue){ SetMetalogixJobPrerequisites -Value "Content Matrix Console - Public Folder
Edition" }

2. Set the directory to the location where the PowerShell script is located.
3. Enter the name and extension of the PowerShell Script (at its specified location), and the script will
run.
In the case that you are running a script from the same directory you would use the format: .
\[ScriptName].ps1. So if your PowerShell scrip was named "ResourceScript.ps1" then you would
enter: .\ResourceScript.ps1 into the window, and the script would run.
If the script is in a different directory, you would enter the location of that directory relative to
your current location, followed by the script name. For example, if your prompt is at the "C:\" drive
and your PowerShell script, named "ResourceScript.ps1" is on the desktop you would enter: C:
\Users\[User]\Desktop\ResourceScript.ps1, and the script would run.
NOTE: In some cases the Execution Policy may prevent you from running a PowerShell script. In this
case you will likely see the message: [Script].ps1 cannot be loaded because the execution of scripts is
disabled on this system. Please see "get-help about_signing" for more details. In this case, running the
command: set-executionpolicy RemoteSigned should change the existing script policy to allow you to
run these scripts for your location. It is advised that you check with your System Administrators
before doing this to ensure that no Company Policies are being broken by this action. If this is an
action you need to take, you should only need to run this command once.
The migration will begin, and any warnings and/or errors that are encountered in running the script will
be displayed in the PowerShell window.

Scheduling a PowerShell Script to Run as a Windows
Scheduled Task
Once a PowerShell script has been created, you can run any migration job as a scheduled task on the
system that the client application is installed on. This can be any migration action that exists in the Job
List section, whether it's a migration job that was saved or a job that was previously run.
The Generate PowerShell Script option saves configurations for the selected job(s) as a PowerShell
script. After the script has been saved, you must create a Windows Scheduled task directly in the
Windows Task Scheduler.
Once these jobs have been created as scheduled tasks they can no longer be viewed (as scheduled
tasks) in Metalogix Content Matrix. If you want to make any other modifications or remove the task
you can do so directly in the Windows Task Scheduler. If a task has been scheduled, the system will be
able to run the task at the appointed time(s), regardless of whether Metalogix Content Matrix client
application is open.
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To schedule a PowerShell script to run via the Windows Task
Scheduler:
1. On the system where the scheduled task will run, open the Windows Task Scheduler.
2. Choose Actions > Create Task.
3. Enter a task Name and Description.
4. In the General tab, go to Security options and specify the user account that the task should be run
under. Change the settings so the task will run regardless of whether the user is logged in.
5. Select the Triggers tab, and click [New] to add a new trigger for the scheduled task. This new task
should use the On a schedule option. The start date can be set to a desired time, and the
frequency and duration of the task can be set based on your specific needs. Click [OK] when your
desired settings are entered.
6. Select the Actions tab and click [New] to set the action for this task to run. Set the Action to Start a
program.
7. In the Program/script box enter "PowerShell."
8. In the Add arguments (optional) box enter the value ".\[Your PowerShell Script Name]." For
example, if your PowerShell Script is named "Migration1.ps1" then you would enter ".
\Migration1.ps1" as the value.
9. In the Start in (optional) box, add the location of the folder that contains your PowerShell script.
NOTE: The location used in the Start in box will also be used for storing the scheduled task run
times, the job history for the copies, and any additional logging that may occur.
10. When all the desired settings are made, click [OK].
11. Set any other desired settings in the Conditions and Settings tabs.
12. Once all the desired actions have been made (or added), click [OK].
The task will be immediately set, and is ready to run.
After the scheduled task has run, a new entry will be added to Metalogix Content Matrix's Job List
section.

Triggering a Job in the Content Matrix Console
to Run Using PowerShell
As an alternative to generating a PowerShell script, you can use PowerShell to trigger jobs that have
been created in the Content Matrix Console.

To access the PowerShell cmdlets for triggering jobs to run:
Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application
framework.
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The following cmdlets for running jobs are now available:
· Get-MLJobs
· Invoke-MLJob

To retrieve information about jobs in the Console:
1. Select (from the PowerShell ISE Command Window) or enter Get-MLJobs.
2. (Optional) Enter one or more of the following parameters if you want to filter jobs:
· JobNameOrTitle
· JobStatus
· Source
· Target

NOTE: If you do not apply filters, all jobs in the Console will be retrieved.
3. Run the cmdlet.
Example scripts:
Get-MLJobs
Get-MLJobs -Source https://outlook.office.com/User mailbox/Drafts -Target
https://metalogixsoftware.sharepoint.com/sites/HR/Ma -JobStatus Failed JobNameOrTitle "Paste Exchange Folder"

To run one or more jobs:
1. Select (from the PowerShell ISE Command Window) or enter Invoke-MLJob.
2. Select or enter additional parameters. Use the information in the following table for guidance.
Parameter

Notes

JobID

· You can obtain the JobId by running the Get-MLJobs cmdlet.
· You can run multiple jobs using the PowerShell Pipeline variable.

JobStatus

Valid statuses are:
· Running

· Warning

· Not Running

· Failed

· Paused

· Queued

· Aborted

· Triggered

Metalogix® Content Matrix Public Folder Edition
Saving or Running a Migration Action

102

Parameter

Notes
· Aborting

· Cancelling

· Done

· Cancelled

Quiet

Use this parameter if you do not want to display a status of the job as it
is running.

RunRemotely

Use this parameter if you want to submit the job for Distributed
Migration.
NOTE: This option is valid for SharePoint Edition only.

3. Run the cmdlet.
Example Scripts
Invoke-MLJob -JobId '92416012-4b69-4d4e-b3c2-984cde279909'
Invoke-MLJob -JobStatus Failed

Run multiple jobs using the PowerShell pipeline variable:
Invoke-MLJob -JobID 'c8176dd1-f1fd-484c-bc66-c002f5406f05' -RunRemotely
'5ca0d97f-4d1d-445f-a6d9-3292abe89a6f', '0a2e0874-a759-46f4-b459bb98ec2991ad' | Invoke-MLJob '30bf6d71-0a28-4012-b612-2d22562b5b46',
'0b094765-46e0-4919-8922-cc5fe841e1f5' | Invoke-MLJob -Quiet

Job Log Files
You can view the progress of a migration tab in real-time via interactive log files. The logs are fully
searchable.

To view an interactive log:
After starting an action, click Details>> in the progress dialog box.
NOTE: All logging in Metalogix Content Matrix is done through jobs. If a job list is deleted from the
Job List, all logging for those actions will also be deleted. There is no backup for the job lists, unless
the job is manually saved to another location. Once a job list is deleted, all logging for the actions
within that job list are gone. Metalogix Content Matrix will automatically hold any job lists created
through any copy or compare actions, in the Job Lists section, and these job lists can only be deleted
through the appropriate Delete commands. The job lists can also be manually selected and saved
through the Job list section.
There are two types of jobs in Metalogix Content Matrix:
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A job list is a collection of job items. A Job list is created for each copy or compare action that is made.
Any "Copy" action/job that is in the Job List section can be used as the base of an incremental copy job.
Job items can be viewed in the Log Viewer, by opening a job list. There are three basic ways to open a
job list to access the Log Viewer:
·

Double-click on a job list.

·

Select a job list, then in the Job List section of the toolbar click View Log.

·

Select a job, right-click, and choose View log.

Job items are job files, or logging, for individual items within the scope of an action. For example, if a
SharePoint site is copied, there would be a job item for adding each list and each item in that list, and
one job item for adding or creating each site or sub-site. If a SharePoint list with five documents is
copied, then there would be a job item for adding/creating the list, and then one job item for adding
each of the documents.

Job items are job files, or logging, for individual items within the scope of an action. For example, if a
SharePoint site is copied, there would be a job item for adding each list and each item in that list, and
one job item for adding or creating each site or sub-site. If a SharePoint list with fie documents is
copied, then there would be a job item for adding/creating the list, and then one job item for adding
each of the documents.
From the Log Viewer you can select and view any job items that exists within that job list.
NOTE: Some actions in Metalogix Content Matrix have the ability to run with Verbose Logging. This
option will increase the size of the log file.

Log Item Details
To view Log Item Details:
1. From the Log Viewer, select the item whose details you want to view.
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2. Use one of the following options:
§

Double-click on the item.

OR
§

Right-click and choose View Job Item.

OR
§

If the job is currently running, click Details>>.

The Job Details dialog contains the following information:
·

Operation - The last operation performed on the item.

·

Status – The status of the item. If a compare action is being performed then this could be:
completed, different, or missing.

·

Item Name - For items, the Item ID. For documents, the Filename.

·

Time Started – The time the action for the item was started.

·

Time Finished – The time the action for the item was finished.

·

Bytes Copied – The bytes (B) that were copied in the action. This will be displayed in KB in some
cases.

·

Source - The Source URL for the item.
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·

Target - Target URL for the item.

·

Information - Provides an informational message about the item, such as. This section will provide
a description for any different and/or missing attributes/metadata for an item.

·

Details View - Any errors that were encountered with the item when an action was performed.

·

Content Comparer tab - Any differences between Source and Target content (from a compare
action). You can display this information in either a Grid View, which displays a metadata property
grid for the item, or as a Text View, which displays a XML text format of the item. This option is
most useful if Verbose Logging has been checked

You can also:
·

Use [Search KBs] to have Content Matrix query the Quest Support Knowledge Base for relevant
articles if you selected a failed item.

·

Use [Copy] to copy all of the item information and details (including the Details tab) into the
system’s clipboard. You can then paste the information when it can then be pasted to another
location. When pasted the information will look similar to that of the actual Log Item Details
dialog. This can be used for easy copy/pasting of an items migration log details.

·

Use [Prev] and [Next] buttons to move to the previous or next item on the list (if applicable).

Exporting Jobs to an Excel File
You can export a selected job or multiple jobs from the Job List section into a Microsoft Excel file. The
export will include all of the operations within each job (whether it is a migration action or some other
action), and their details. This is to help users better understand their migration data and results, and
provides another way to review the resulting logs.
In addition to the log details that are provided, there are also a number of tables and charts that can be
accessed in different tabs within the Excel file. These tables and charts will help breakdown the
information in a more visible manner.

To export one or more jobs to an Excel file:
1. In the Job List, select the job(s) you want to export.
2. Use one of the following options:
§

From the Job List menu, select Export Excel

OR
§

Right-click and choose Export selected job to Excel.

3. Save the file to the desired location.
By default the Excel file will open after it has been created. This process may take a few minutes
depending on the size of the selected job(s) and the number of actions in the log(s).
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Information in Exported Excel Files
When an Excel file is exported from the Metalogix Content Matrix Job List there are a number of page
tabs that can be viewed. Each page tab will display a different set of data, and some of these tabs will
also display pivot graphs (with pivot tables behind them).
NOTE: The data within all of these Excel tabs (both the tables and the graphs) should only be
considered a starting point when looking at your migration data. You can modify the existing graphs
through various methods, such as applying filters, changing the data values, etc. You can also take the
"raw" data from the LogItems tab and use it to create your own graphs or sets of data as required.
The exported file contains the following tabs:
·

Jobs - All of the specific jobs that are included in the export. This includes migration jobs as well as
other actions.

·

LogItems - All of the operations that have been run by Metalogix Content Matrix and provide all of
the logging details that are available in the Log Viewer and Log Item Details windows. Some
examples of these operations are: adding lists, adding content types, copying documents, adding
users, updating lists, etc.

·

Error Rates - A a graph that represents the number of errors and warnings that Metalogix Content
Matrix encounters during a migration on a "per minute" basis. The vertical axis will list the number
of errors/warnings that are encountered (at the specified time), and the horizontal axis lists the
amount of time (displayed in a "per minute" value). The horizontal axis can also be changed to
display in month, day, or hour time values as well. Below the graph is a table that provides a
different view of the same error/warning breakdown.
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·

Operation Counts - The number of operations/actions that are run over a period of time. Some
examples are: copying sites, copying lists, copying documents, adding SharePoint groups, adding
users, copying permissions, etc., and each operation has its own line representation on the graph.
The vertical axis lists the number of operations that are running (at the specified time), and the
horizontal axis lists the amount of time (this is displayed in a "per minute" value). The horizontal
axis can also be changed to display in month, day, or hour time values as well. Below the graph
there is a table that provides a different view of the same migration operation data.

·

Operation Duration - The total duration of time for each operation/action type against the total
migration time. This is potentially the most confusing graph to read in the exported Excel file. The
vertical axis lists the total duration time for each action. This is determined by finding the
difference between each operation/actions Time Started and Time Finished values, and then
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adding the totals together for all of that operation/actions of that type that are running. This is
then displayed against the horizontal axis which lists the time (displayed in a "per minute" value) for
the migration. The horizontal axis can also be changed to display in month, day, or hour time values
as well. Below the graph there is a table that will provide a different view of the same migration
data.

An example of how to read this graph is: if at minute 25 (of the hour, not the 25 minute of the
migration) a large number of small documents are copied and completed (all in the 25th minute),
then at minute 25 in the graph there will likely be a spike in the "duration time" for the "Copying
Document" operation/action. If each document was copied in 2 seconds, and there were 41 small
documents, then the Sum of Duration value would be listed as 82 seconds (or 0:01:22). So the
results in the graph would show a spike for the Copying Document operation/action and minute
25, with a value of 0:01:22.
·

Operation Throughput – The amount of data/throughput (in MB) that is migrated on a "per
minute" basis. The vertical axis lists the amount of data that is being pushed through Metalogix
Content Matrix for a given operation (at the specified time), and the horizontal axis lists the time
(displayed in a "per minute" value) at which that the action was performed. The horizontal axis can
also be changed to display in month, day, or hour time values. Below the graph there is a table that
will provide a different view of the same throughput data.
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Copying Job Logging to Other Applications
It is possible to copy the results of migration jobs from log files to other applications. This can be
beneficial if you want to keep track of copy or incremental information outside of Metalogix Content
Matrix, or want to manipulate the information for reporting or retention purposes. The log information
is copied as text, to the clipboard, and can then be pasted within any other application that allows text
pasting. For example, if a copy action was made, the logging can be copied into a Word file, or into an
Excel spreadsheet, then saved.
NOTE: Only the end results of the total action will be copied.
To copy the logging for a job list:
1. Select a job from the Job List.
2. Right-click, and choose Copy selected job to clipboard (alternately Ctrl+C can be used).
3. Open the desired target program (for example: Microsoft Word, Microsoft Excel, Notepad, etc),
then paste the content into the application (Ctrl+V, or the paste command in the application
itself).
NOTE: The logging for each action within the list must be copied separately.
To copy the logging for job items:
·

Select the desired job list or job item(s) that the logging is to be copied from, and open the job list
to access the Log Viewer.

·

Select any job items that are to be copied. Single or multiple items can be selected in the Log
Viewer. In order to copy the logging for the entire job, all job items in the Log Viewer must be
selected.
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·

When all of the desired items are selected, right-click on one of them, and select Copy Log Items to
Clipboard, and select to either copy them with, or without details. The Details are a set of extra
columns that are added to the logging. These columns are typically: Details, SourceContent, and
TargetContent. These columns do not always contain extra information. The default copy option
(Ctrl+C) is to copy the logging without the Details.

Creating a Support Zip File for a Migration Job
You can generate a zip file of data associated with a single job item to help Quest Support facilitate
troubleshooting.
The high-level data collected in the zip file includes:
·

Application Settings files.

·

Product information (product version, license, etc.).

·

Information about the job item (what action settings were set, the job log, etc.).
IMPORTANT: Please review the contents of the zip file before sending it to Support. While this
feature attempts to only collect non-sensitive data, no guarantees can be made - it is up to you to
ensure that any files in the zip folder are stripped of any confidential data. Regardless, Quest assures
that the contents of the zip file will only be used for troubleshooting the associated support ticket.

To create a support zip file:
1. In the Job List, select the job for which the zip file is to be generated.
2. Use one of the following options:
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§

In the main ribbon, click the Help tab, then Create Support Zip File.

§

Right-click and choose Create Support Zip File.

3. Save the file to the desired location using the desired file name.
4. If you wish to review the zip file for sensitive information, click Yes to open the zip file. Once you
are satisfied with the contents of the zip file, it can be sent to Quest Support to aid in
troubleshooting.

Enabling Trace Logging
You can enable trace logging on the machine where Content Matrix is installed and migrations are run
to assist Quest Support with troubleshooting.
NOTE: For Distributed Migration, trace logging must be enabled on each agent machine.

To enable trace logging:
1. Open the file LogSettings.xml, which can be found in one of the following folders:
· If you are required to be a local administrator on the machine where Content Matrix is installed: C:

\ProgramData\Metalogix
OR
· If you are not required to be a local administrator on the machine where Content Matrix is

installed: C:\Users\<username>\AppData\Roaming\Metalogix\Common
2. Set <LoggingLevel> to one of the values described in the following table.
WARNING: When trace logging is enabled, entries are appended to the log file for each migration
job that is run, and the same log file is used for all editions. This means the log file can become
very large, which is why it is recommended that you only enable trace logging at the request of
Quest Support.
Value

Description

None [Default]

Trace logging is disabled (i.e., no entries are written to the log file).

Error

Only Error messages are logged.

Debug

Error and Debug messages are logged.
NOTE: Debug should only be used for advanced troubleshooting as it may
impact migration performance.

Log entries are written to the file MetalogixGlobalLog.txt, which is located in the same folder as
LogSettings.xml.
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11
Using PowerShell with Content
Matrix
Metalogix Content Matrix can generate PowerShell scripts to be used to migrate SharePoint content
through the PowerShell command window. You can also use PowerShell to perform other actions,
including:
· connecting to SharePoint
· triggering a job in the Content Matrix Console to run

The Content Matrix PowerShell Console shortcut is added to the same Start Menu folder location
where the to Metalogix Content Matrix Consoles are placed after installation. The same PowerShell
console can be used for any edition, as long as the edition-specific snap-ins are used. You can also use
a standard PowerShell console or PowerShell ISE.

Adding the PowerShell Snap-Ins for the
Application Framework
Whenever a new PowerShell session is launched, the edition-specific snap-ins must be added before
you can perform a Content Matrix action.
NOTES:
· If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.
· If Content Matrix settings change, in order to apply new settings all PowerShell sessions must be

restarted.

To add the PowerShell cmdlets for the application framework:
1. Open a Powershell ISE or PowerShell console session.
2. Copy and paste the PowerShell snap-ins from the Quest Support Knowledge Base article located at
https://support.quest.com/metalogix-content-matrix/kb/333879.

Metalogix® Content Matrix Public Folder Edition
Using PowerShell with Content Matrix

113

Content Matrix PowerShell Commandlet List
Metalogix Content Matrix can generate PowerShell script for you, for any migration action that is
available through it. The below cmdlets are used in the generated PowerShell script, but can also be
used to write your own script, should you desire to do so. For more information on each cmdlet, simply
type get-help [cmdlet]. For example, if you want more information on Copy-MLSharePointList cmdlet
you would enter get-help Copy-MLSharePointList, followed by the Enter (return) key.
Below is a list of the available cmdlets (and their parameters), broken up into the available commands
for each snap-in.

Metalogix.System.Commands
Set-ApplicationDataPath
· Path - The path to be used as the root folder for the application path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the
application data will be contained within those folders. (Mandatory)
· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the application data folder.

Set-CommonDataPath
· Path - The path to be used as the root folder for the common data path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the
common data will be contained within those folders. (Mandatory)
· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the common data folder.

Get-MetalogixConfigurationVariable
· Name - The name of the configuration variable. (Mandatory)
· ValueType - Specify the value type of the configuration variable. This type must be IConvertible.

(Default: IConvertible).
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New-Filter
· PropertyName - The name of the parameter to compare the value to on the object being filtered.

(Mandatory)
· Operand - The operand to use to compare the specified value to the given property value.

(Mandatory)
· Value - The value to compare the given property to. (Mandatory)
· CaseSensitive - Indicates if the comparison should be case-sensitive. This parameter is only

meaningful when the property to be compared to is a string.
· TypeName - The name of a type to apply the filter to. If not specified, the filter will apply to any

object.

Join-Filter
· Logic - The logic to use in the join (and or or). (Mandatory)
· FilterExpression - The filter object to join together. Can be a set of filters). (Mandatory)

Invoke-Filter
· Objects (Mandatory)
· Filter (Mandatory)

Load-MetalogixConfigurationVariableSettings
· FilePath - The full file path of the configuration variable settings file to load. (Mandatory)
· Scope - The scope to load these settings into. (Default: Environment).
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New-MetalogixSerializableObject
· TypeName - The name of the type of object to create. (Mandatory)
· AssemblyName - The name of the assembly containing the type to be created. (Mandatory)
· SerializedValue - The XML representation of a single serializable Metalogix object. (Mandatory)
· Enumerate - If set, any collections returned by the cmdlet will enumerated. Otherwise, collections

will be returned as a single object.

New-MetalogixSerializableObjectCollection
· SerializedValue - The XML representation of a Metalogix object collection. Generally this will be

obtained by requesting the PowerShell command for a job configured in the GUI. This cmdlet is not
recommended for general use. (Mandatory)

Set-MetalogixConfigurationVariable
· Scope - The scope of the configuration variable. Possible values are Environment,

EnvironmentSpecific, User, UserSpecific, Application, ApplicationSpecific,
ApplicationAndUserSpecific. (Default: ApplicationAndUserSpecific). (Mandatory)
· Name - The name of the configuration variable. (Mandatory)
· Value - The value of the configuration variable. (Mandatory)

Set-MetalogixDefaultResolverSetting
· Name - The name of the configuration variable ("ResourceTableResourceTableLink"). (Mandatory)
· Value - The value of the configuration variable. This value will indicate where to obtain configuration

key settings from. Options are local file system ("Metalogix.ResourceFileTableResolver") or agent
database (Metalogix.Core.ConfigVariables.ResourceDatabaseTableResolver). (Mandatory)
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Metalogix.SharePoint.Commands
Add-MLSharePointSiteCollection
· WebApplicationName - Name of the Web Application to Create the Site Collection in. Web

Application must exist in the specified Target. (Mandatory)
· WebTemplateName - Web (Site) Template to use for the Site Collection. Web (Site) Template must

exist. The value must be in the form name#configuration. E.g., STS#1 for Blank Site (Mandatory)
· Language - Language to use for the Site Collection. Can be Language Code (LCID) or Language

Name. Language must exist in the specified Target. (Mandatory)
· ExperienceVersion - The experience version to use when creating the site. This setting is only used

for SharePoint 2013. Use 15 for the 2013 UI and 14 for the 2010 UI.
· Title - The Title for the Site Collection. (Mandatory)
· Description - Description for the Site Collection.
· Path - Managed Path for the Site Collection. Include forward-slash characters where required. E.g.,

"/sites/" or "/sites/". (Mandatory)
· URL - Server Relative portion of URL solely used to identify the Site Collection itself. E.g.,

"TestSiteCollection" (Mandatory)
·
· OwnerLogin - Domain and username to be used as the Primary Administrator for the Site Collection.

E.g., "sampledomain\sample.user" (Mandatory)
· SecondaryOwnerLogin - Domain and username to be used as the Secondary Administrator for the

Site Collection. E.g., "sampledomain\another.user"
· ContentDatabaseName - Content Database Name to use. Not specifying this value will use the

default content database (auto detect).
· SelfServiceCreateMode - Allow users without Farm Administrator privileges to add the Site

Collection.
· SetSiteQuota - Set Quota for the Site Collection.
· QuotaMaximum - Limit site storage to maximum size (Mb). SetSiteQuota must be set to true and

SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.
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· QuotaWarning - Send a warning email when the site storage reaches this size (Mb). SetSiteQuota

must be set to true and SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.
· QuotaID - Use Quota Template. Can be the integer ID or the string name of the Quota. SetSiteQuota

must be set to true and SelfServiceCreateMode should be false.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-Permissions
· Name - The name of the user or group you wish to assign a permission level to. (Mandatory)
· PermissionLevel - The name of the permission level you want to grant the specified user or group.

(Mandatory)
· Recurse - A flag that indicates the given permissions level should be granted to the given user for

each item below the target which has unique permissions.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Add-SharePointFolder
· Name - The name of the folder to be created. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointList
· Name - The name for the new list. (Mandatory)
· TemplateName - The numeric code of the template to use. (Mandatory)
· Description - A description of the list.
· Title - The title for the new list.
· IsOnQuickLaunch - Indicates if the list should be added to the quick launch.
· HasVersions - Indicates if the list should enable major versions.
· HasMinorVersions - Indicates if the list should enable minor versions.
· RequiresContentApproval - Indicates if the list should require content approval.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
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· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointSite
· URL - The URL name for the new site. If not specified, it will be automatically generated from the

given name.
· Name - The name for the new site. (Mandatory)
· TemplateName - The name of the template to use, either in [Name]#[Config] form or by the name

of the STP file. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Clear-GlobalMappings
·

ClearGuidMappings - Indicates that global GUID mappings should be cleared.

·

ClearURLMappings - Indicates that global URL mappings should be cleared.

·

ClearUserMappings - Indicates that global user mappings should be cleared.

·

ClearDomainMappingss - Indicates that global domain mappings should be cleared.
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Compare-MLSharePointFolder
· CompareFolders - Indicates whether or not to compare folders.
· CompareItems - Indicates whether or not to compare items.
· CompareVersions - Indicates whether or not to compare item versions.
· CompareMetadata - Indicates whether or not to compare object metadata.
· VerboseLog - Indicates whether or not to compare object metadata.
· HaltIfDifferent - Indicates whether or not to halt the comparison if a difference is encountered.
· FilterListsAndFolders - Indicates whether or not to filter lists and folders.
· ListAndFolderFilterExpression - The filter expression applied to lists and folders.
· FilterItemsAndVersions - Indicates whether or not to filter list items and their versions.
· ItemAndVersionFilterExpression - The filter expression applied to list items and versions.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Compare-MLSharePointList
This is the same as Compare-MLSharePointFolder with additional parameters.

Metalogix® Content Matrix Public Folder Edition
Using PowerShell with Content Matrix

121

Compare-MLSharePointSite
This is the same as Compare-MLSharePointList with additional parameters:
· CompareLists - Indicates whether or not to compare lists.
· CompareSubSites - Indicates whether or not to compare sub sites.
· FilterSubSites - Indicates whether or not to filter sub sites.
· SubSiteFilterExpression - The filter expression applied to sub sites.

Get-MLSharePointDatabase
·

Server - The name of the database server. (Mandatory)

·

Database - The name of the SharePoint content database. (Mandatory)

·

User - A user to connect as, in DOMAIN\Login format.

·

Password - The password for the user provided.

Get-MLSharePointFolder

This is the same as Get-MLSharePointList with an additional parameter:
·

FolderPath - The list-relative path to the desired folder, seperated by "/". (Mandatory)

Get-MLSharePointFolderFromDatabase
This is the same as Get-MLSharePointListFromDatabase with an additional parameter:
·

FolderPath - The list-relative path to the desired folder, separated by "/". (Mandatory)

Get-MLSharePointItembyFileName
· FileName - The filename of the SharePoint document. (Mandatory)
· FolderPath - The list-relative path to the desired folder, separated by "/".
· ListName - The name of the desired list. (Mandatory)
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· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)
· User - A user to connect as, in DOMAIN\Login format.
· Password - The password for the user provided.
· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service is
installed.
· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItembyID
· Id - The ID of the SharePoint item. (Mandatory)
· FolderPath - The list-relative path to the desired folder, separated by "/".
· ListName - The name of the desired list. (Mandatory)
· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)
· User - A user to connect as, in DOMAIN\Login format.
· Password - The password for the user provided.
· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where our Metalogix Extensions Web Service is
installed.
· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItemFromDatabase

This is the same as Get-MLSharePointListFromDatabase with additional parameters:
·

FolderPath - The list-relative path to the desired folder, separated by "/".

·

ItemName - The filename or ID of the desired item. (Mandatory)
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Get-MLSharePointList

This is the same as Get-MLSharePointSite with an additional parameter:
·

ListName - The name of the desired list. (Mandatory)

Get-MLSharePointListFromDatabase
This is the same as Get-MLSharePointSiteFromDatabase with an additional parameter:
·

ListName - The name of the desired list. (Mandatory)

Get-MLSharePointServer
·

ServerURL - The URL of the SharePoint server to connect to. (Mandatory)

·

User - A user to connect as, in DOMAIN\Login format.

·

Password - The password for the user provided.

·

ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointSite
·

SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

·

User - A user to connect as, in DOMAIN\Login format.

·

Password - The password for the user provided.

·

AdapterType - The short name of the adapter type you want to use for the connection. Use OM
for a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service
is installed.

·

ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointTenant
·

TenantURL - The URL of the SharePoint tenant to connect to. (Mandatory)

·

User - A user to connect as, in user@company.onmicrosoft.com format. (Mandatory)

·

Password - The password for the user provided. (Mandatory)

·

ReadOnly - Indicates that the connection made to the SharePoint tenant should be read-only.
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Get-SharePointSiteFromDatabase
·

Server - The name of the database server. (Mandatory)

·

Database - The name of the SharePoint content database. (Mandatory)

·

SiteURL - The server-relative URL of the SharePoint site to connect to.

·

User - A user to connect as, in DOMAIN\Login format.

·

Password - The password for the user provided.

·

HostHeader - A host header for a specified subsite. Use this if you are connecting to a site or
subsite with a host header name.

Refresh-SharePointNode
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointFolder
· Folder - The Folder object retrieved by using the Get-MLSharePointFolder Cmdlet. (Mandatory)
·
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
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· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointItem
· Item - The ListItem object retrieved by using the Get-MLSharePointItem Cmdlet. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointList
· List - The list object retrieved by using the Get-MLSharePointList Cmdlet. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointSite
· Site - The site object retrieved by using the Get-MLSharePointSite Cmdlet. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointSiteCollection
· SiteCollection - The Site Collection object retrieved by using the Get-MLSharePointSite Cmdlet.

(Mandatory)
· Server - The parent Server object of the Site Collection, retrieve by using the Get-

MLSharePointServer Cmdlet. (Mandatory)
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Search-SharePointSite
· SearchTerm - The search term to use.
· MaxResults - The number of search results to output.
· MatchExactly - Indicates that the search term must match one of the searched fields exactly.
· Recursive - Indicates that data within all subwebs should be included in the search.
· IncludeItems - Indicates that the search results should include items.
· IncludeDocuments - Indicates that the search results should include documents.
· IncludeFolders - Indicates that the search results should include folders.
· IncludeLists - Indicates that the search results should include lists.
· IncludeSites - Indicates that the search results should include sites.
· ContentType - If specified, search results must include this value in their content type name.
· Author - If specified, search results must have been created by an author matching this value.
· Editor - If specified, search results must have been modified by an editor matching this value.
· CreatedBefore - If specified, search results must have been created before this date.
· CreatedAfter - If specified, search results must have been created after this date.
· ModifiedBefore - If specified, search results must have been modified before this date.
· ModifiedAfter - If specified, search results must have been modified after this date.
· Transformers - The collection of data transformers which the action needs to run. Note that if the passed-in

value for this parameter does not include transformers which are considered mandatory, they will be added
automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is invalid, an

exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the 'JobDatabase'
parameter will take precedence and the job will only be written to the job database.

Metalogix® Content Matrix Public Folder Edition
Using PowerShell with Content Matrix

128

Update-SharePointSiteCollectionSettings
· SiteCollectionAdmins - A list of login names to be granted site collection administrator privileges.
· QuotaMaximum - An independently defined maximum storage size for this site collection.
· QuotaWarning - An independently defined size at which to send a warning email for this site

collection.
· QuotaID - A quota template ID to use for this site collection.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Metalogix.Jobs.Reporting.Commands
Export-JobHistory
· SqlCeDbFilePath - Specify the path to the SQL database file that contains the Job History data.

(Mandatory)
· ServerName - The name of the SQL Server. (Mandatory)
· DatabaseName - The name of the Job History database. (Mandatory)
· AuthType - Indicates whether to use Integrated (Windows) or SQL Authentication. If not specified

will Integrated Authentication will be used.
· Username - Specify the username for SQL Authentication.
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· Password - Specify the password for SQL Authentication.

Metalogix.Exchange.Commands
Copy-ExchangeItem
· UserMapper - Defines the user mapping between Exchange and SharePoint users.
· KeepAllDayEvent - Indicates how all day events should be copied between different time zones. If

this switch is on all day events will start in the same local time (hours:minutes) in target as were
defined in source. Time zone difference is not calculated.
· OutputType - Defines the format in which Exchange items will be migrated to SharePoint. Possible

options are: msg, eml.
· SelectedFields - Defines fields which will be migrated from Exchange item to SharePoint item.
· ContainerSplitLimit - Defines the limit for item count in SharePoint lists. If the item count in source

Exchange folder reaches this limit, items will be placed in separate folders, which will be created on
the fly. These folders will contain no more items than the defined limit.
· VerboseLogging - Indicates if the more detailed logging should be enabled.
· Overwrite - Indicates if the copy operation should overwrite existing items and documents.
· Filters - Defines a filter expression used to determine if a document or item should be copied.
· ContentTypeOptions - Defines a set of content type application rules for the item copying

operation.
· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.
· Quiet - If set, the operation will not report progress to the PowerShell console.
· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
· Source - The source node for the actions.
· Target - The target node for the actions.
· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Copy-AllExchangeFolderItem
This is the same as Copy-ExchangeItem with additional parameters.

Copy-ExchangeFolder
This is the same as Copy-ExchangeItem with additional parameters:
· PermissionMapper - Defines the mapping between Exchange and SharePoint permissions.
· SkipNonMappedPermissions - Indicates if the non mapped users should be skipped.
· ShowSubSite - Indicates if the site created for migration should be displayed in the navigation line.
· CopyPermissions - Indicates if the permissions should be copied.
· CreateSite - Indicates whether a new site should be created for the migration.
· SiteName - Defines the name of the site which will be created for the migration. All data will be

migrated to this site.
· WebTemplateID - Defines the web template id.
· WebTemplateConfig - Defines the web template configuration.
· WebTemplateName - Defines the web template which will be applied to SharePoint sites during the

migration.
· IsSiteHierarchy - Indicates if the folder hierarchy should be created using sites.
· EnableTreeViewOnSite - Indicates if the tree view navigation should be enabled and shown in the

SharePoint environment easing navigation.

Copy-ExchangeFolderToList
This is the same as Copy-ExchangeFolder with additional parameters.
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12
Modifying Content Matrix
Configuration and Settings
You can configure and customize a number of Metalogix Content Matrix settings, including:
·

the use of encrypted SQL database connections

·

proxy settings

·

available actions and events

·

default settings in configuration variable files

·

client-side settings

·

resource utilization settings

Using Encrypted SQL Database Connections
When connecting to a full SQL Content Matrix Job Database, you are given the option to connect using
TLS/SSL encryption.
NOTE: Content Matrix can use any version of TLS that is compatible with .NET Framework 4.7.2. The
default version of TLS used by the operating system on the machine from which you are connecting
will be used by Content Matrix.

The encrypted connection can use either:
· a self-signed certificate or a trusted certificate from the third party authority (refer to the Microsoft

article https://docs.microsoft.c om/en-us/sql/database-engine/configure-windows/enable-
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encrypted-connections-to-the-database-engine?view=sql-server-ver15 for instructions on

configuring an encrypted connection using a certificate)
OR
· a SQL-generated certificate, which does not require configuration.

NOTE: If a trusted certificate is used, it is not necessary to check the Trust Server Certificate box.
However, if the box is not checked and the certificate is not trusted, the following message will
display:

In this case, the Trust Server Certificate box must be checked in order to continue the connection.

Configuring Proxy Settings
In most cases Metalogix Content Matrix can automatically connect to SharePoint and authenticate
license keys, through an environment's proxy setting, However, in some cases the proxy may need to
be configured within Metalogix Content Matrix. In these cases users can specify the proxy settings
though the connecting dialog.
There are two basic places where this proxy setting can be configured. The first of these is when
activating a license key, and the second when connecting to SharePoint. The dialogs for these options
look slightly different, and the when you are using a proxy to connect to SharePoint, you have the
additional option to Import Proxy from Internet Explorer.
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To configure proxy settings:
1. In the Proxy server dialog, check the Enable proxy box.
2. Use the information in the following table to determine the appropriate action to take.
If ...

Then ...

you want to
A. Select Enter Manually.
manually enter
proxy information B. Enter the Server name (or IP) and Port for the proxy.
C. Specify the credentials to be used when connecting to the target server.
The Windows authenticated credentials of the current user will be
selected by default. You can specify alternate SharePoint credentials by
clicking the Different user radio button, and entering an alternate
username and password.

Internet Explorer select Import Proxy from Internet Explorer.
has been
configured to use
a proxy server via
a proxy autoconfiguration
(.PAC) file and you NOTE: This option is currently available only when connecting to
want to connect
SharePoint.
to SharePoint
Refer to the Microsoft article Auto proxy configuration settings for Internet
using this method
Explorer for more information.
3. If you accessed the dialog from the License Activation dialog, click [Set].
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NOTE: If this method does not seem to be working, you can manually configure Metalogix Content
Matrix to use a proxy setting. See Manually Configuring Proxy Settings.

Manually Configuring Proxy Settings
If, for some reason, Metalogix Content Matrix cannot connect through a proxy, then the proxy settings
can be configured through the Metalogix Content Matrix UI. If you are not able to configure the proxy
settings through the product's UI for some reason, it can be configured manually. The below directions
should help you manually configure some explicit proxy settings, enabling the product to work with
your proxy.

To manually configure proxy settings:
1. Open the Metalogix Content Matrix Console and add a connection to the desired SharePoint
location.
2. After a connection has been added, close Metalogix Content Matrix.
3. Open the ActiveConnections.xml file, which can be found in the following locations, in a text
editor:
C:\Users\<USER>\AppData\Roaming\Metalogix\Metalogix Content Matrix Console - <Product>
Edition
Within the XML file there is a <Connection /> XML element for each added connection. In order for
proxy settings to be added to a connection, another element needs to be added inside the
connection XML. The added element should be named Proxy, and it should have an attribute
named URL. The value for this URL attribute should be the actual URL for the proxy that will be
used.
For example, if we are trying to add a proxy connection to the following node:
<Connection NodeType="Metalogix.SharePoint.SPWeb, Metalogix.SharePoint,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=3b240fac3e39fc03"
AdapterType="WS" URL=http://SharePoint2010 />

We would add: <Proxy URL="http://metalogixproxy:8000/" />. So the end result
would be:
<Connection NodeType="Metalogix.SharePoint.SPWeb, Metalogix.SharePoint,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=3b240fac3e39fc03"
AdapterType="WS" URL="http://SharePoint2010">
<Proxy URL="http://metalogixproxy:8000/" />
</Connection>

If the proxy connection requires a user name and password that differ from your normal logged in
Windows credentials, then these can also be specified in the Proxy element. The attribute
UserName can be used to enter a user name (in domain\user format), and an attribute named
Password can be used to enter the password value.
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In this case the Proxy value <Proxy URL="http://metalogixproxy:8000/" /> would
become:
<Proxy URL="http://metalogixproxy:8000/" UserName="DOMAIN\ProxyUser"
Password="ProxyPassword" />

4. After these values have been entered to the desired connection, save and close the
ActiveConnections.xml file.
5. Re-launch Metalogix Content Matrix.
The connection using the proxy should now be configured, and the connection should be
established and working.

Restricting Available Actions and Suppressing
Events
Metalogix Content Matrix provides you with the ability to control what actions are available to the
client application through configuring on the SharePoint server. Product behaviors can be restricted
along three dimensions:
·

Available actions

·

Unrestricted users

·

Suppressed events

Configuring the behavior of the Metalogix Content Matrix client from target SharePoint servers
requires that an XML configuration file be added to the target SharePoint server web application
directory. The XML file must be named ServerAdapterConfig.xml and placed in the ML folder directory
located within the SharePoint hive (this is the same directory where the Metalogix SharePoint
Extensions Web Service files are). Below are some examples of the typical directory location of the ML
folder, depending on SharePoint product version and configuration:
· SharePoint 2013: - C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\15\isapi\ML
· SharePoint 2016: - C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\16\isapi\ML
· SharePoint 2019:- C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\16\isapi\ML

ServerAdapterConfig.xml File Format
Below is an example of the simple XML format required for ServerAdapterConfig.xml.
<ServerAdapterConfig>
<DisabledActions>
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<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteActi
on</Action>
<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteColl
ectionAction</Action>
<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteList
s</Action>
<Action>Metalogix.SharePoint.Actions.Migration.CopyRoleAssignme
ntsAction</Action>
<Action>Metalogix.SharePoint.Actions.Migration.CopyWorkflowAsso
ciationsAction</Action>
<Action>Metalogix.SharePoint.Actions.Migration.PasteFolderActio
n</Action>
</DisabledActions>
<ExemptUsers>
<User>METALOGIX\geordie</User>
<User>METALOGIX\julien</User>
</ExemptUsers>
<SuppressEvents>False</SuppressEvents>
</ServerAdapterConfig>
There are three main sections within the root ServerAdapterConfig section of this XML:
·

DisabledActions: This section defines the set of actions that cannot be run on the client. See
Actions That Can Be Disabled on the Server Side for a complete list.

·

ExemptUsers: This section defines the set of users by user name who are exempt from any
DisabledActions. In other words, a user in the ExemptUsers is not subject to any restrictions
imposed on Metalogix Content Matrix clients by the DisableActions section.

·

SuppressEvents: This section defines if any of SharePoint's event receivers are suppressed/disabled
during a migration and then restarted once the action is complete. The value for this section is set
to "True" by default, but can be manually configured if want event suppression to be disabled.
Suppression of event receivers allows Metalogix Content Matrix to avoid any potential
concurrency issues when migrating (mainly with regards to workflows).

Actions That Can Be Disabled
Many of the SharePoint related actions available in the Metalogix Content Matrix Console can be
disabled on the server side. The table below lists the complete set of client actions that can be disabled
from the server and provides the format of the action name required in the DisabledActions section of
the ServerAdapaterCongifuration.xml file.
NOTE: When an action that is available via the client UI is disabled on the server, it will be visible in
client menus but disabled.
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Action

Configuration File Format

Change Global
Navigation Settings

Metalogix.SharePoint.Actions.Administration.ChangeGlobalNavigationActio
n

Change Quick Launch

Metalogix.SharePoint.Actions.Administration.ChangeQuickLaunchAction

Create Folder

Metalogix.SharePoint.Actions.Administration.CreateFolderAction

Create List

Metalogix.SharePoint.Actions.Administration.CreateListAction

Create List From XML

Metalogix.SharePoint.Actions.Administration.CreateListFromXMLAction

Create Site

Metalogix.SharePoint.Actions.Administration.CreateSiteAction

Create Site Collection

Metalogix.SharePoint.Actions.Administration.CreateSiteCollection

Create Site Collection
in Self-Service Mode

Metalogix.SharePoint.Actions.Administration.CreateSiteCollectionSelfServic
eMode

Delete Discussion Item Metalogix.SharePoint.Actions.Administration.DeleteDiscussionItem
Delete Item

Metalogix.SharePoint.Actions.Administration.DeleteFolder

Delete List

Metalogix.SharePoint.Actions.Administration.DeleteItem

Delete Site

Metalogix.SharePoint.Actions.Administration.DeleteList

Delete Site Collection

Metalogix.SharePoint.Actions.Administration.DeleteSite

Export Doc Items

Metalogix.SharePoint.Actions.Administration.DeleteSiteCollection

Publish Documents
and Pages

Metalogix.SharePoint.Actions.Administration.PublishDocumentsandPagesAc
tion

Update Site Collection Metalogix.SharePoint.Actions.Administration.UpdateSiteCollectionSettingsA
Settings
ction
Add Role Assignments

Metalogix.SharePoint.Actions.Migration.AddRoleAssignmentsAction

Copy Folder
Permissions

Metalogix.SharePoint.Actions.Migration.CopyFolderPermissions

Copy Item Alerts

Metalogix.SharePoint.Actions.Migration.CopyItemAlertsAction

Copy List Alerts

Metalogix.SharePoint.Actions.Migration.CopyListAlertsAction

Copy List Permissions

Metalogix.SharePoint.Actions.Migration.CopyListPermissions

Copy List Role
Assignments

Metalogix.SharePoint.Actions.Migration.CopyListRoleAssignments

Paste Web Parts

Metalogix.SharePoint.Actions.Migration.CopyWebPartsAction

Paste Master Page
Gallery

Metalogix.SharePoint.Actions.Migration.CopyMasterPageGalleryAction

Paste Content Types

Metalogix.SharePoint.Actions.Migration.CopySiteContentTypesAction
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Action

Configuration File Format

Paste All Subsites

Metalogix.SharePoint.Actions.Migration.CopySubSitesAction

Copy Web Alerts

Metalogix.SharePoint.Actions.Migration.CopyWebAlertsAction

Copy Web Permissions Metalogix.SharePoint.Actions.Migration.CopyWebPermissions
Paste Workflow
Associations

Metalogix.SharePoint.Actions.Migration.CopyWorkflowAssociationsAction

Paste All List Items

Metalogix.SharePoint.Actions.Migration.PasteAllListItemsAction

Paste All List Items
into Items View

Metalogix.SharePoint.Actions.Migration.PasteAllListItemsIntoItemsViewActi
on

Paste Audiences

Metalogix.SharePoint.Actions.Migration.PasteAudiencesAction

Paste Default Web
Part Page

Metalogix.SharePoint.Actions.Migration.PasteDefaultWebPartPageAction

Paste Duplicate List

Metalogix.SharePoint.Actions.Migration.PasteDuplicateListAction

Paste Duplicate Site

Metalogix.SharePoint.Actions.Migration.PasteDuplicateSiteAction

Paste Folder

Metalogix.SharePoint.Actions.Migration.PasteFolderAction

Paste List

Metalogix.SharePoint.Actions.Migration.PasteListAction

Paste List as Folder

Metalogix.SharePoint.Actions.Migration.PasteListAsFolderAction

Paste List Email
Notifications

Metalogix.SharePoint.Actions.Migration.PasteListEmailNotificationAction

Paste List Item

Metalogix.SharePoint.Actions.Migration.PasteListItemAction

Paste List Item into
Items View

Metalogix.SharePoint.Actions.Migration.PasteListItemIntoItemsViewAction

Paste My Sites

Metalogix.SharePoint.Actions.Migration.PasteMySitesAction

Paste Navigation

Metalogix.SharePoint.Actions.Migration.PasteNavigationAction

Paste Roles

Metalogix.SharePoint.Actions.Migration.PasteRolesAction

Paste Site

Metalogix.SharePoint.Actions.Migration.PasteSiteAction

Paste Site Collection

Metalogix.SharePoint.Actions.Migration.PasteSiteCollectionAction

Paste Site Content

Metalogix.SharePoint.Actions.Migration.PasteSiteContentAction

Paste Site Lists

Metalogix.SharePoint.Actions.Migration.PasteSiteLists

Remove Role
Assignments

Metalogix.SharePoint.Actions.Migration.RemoveRoleAssignmentAction

Event Suppression

Metalogix.SharePoint.Actions.Migration.SuppressEvents
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Note that many of the above listed actions are used by other actions. When a given action is enabled,
but one or more of its sub-action is disabled, the sub-actions will not run. When a user attempts to run
an action for which sub-actions are disabled, they will be notified with a dialog similar to the following:

Configuration Variable Files
Metalogix Content Matrix uses a set of configuration variable files behind the scenes to help set and
manage settings for all of the Metalogix Content Matrix Editions. This section explains what the
configuration variable files are, their general behavior, and where to find them.
Configuration variables are contained in the following three files:
·

EnvironmentSettings.xml

·

UserSettings.xml

·

ApplicationSettings.xml

Some settings can be configured for all Product Editions, while other settings are limited to individual
Product Editions.
Any settings that are configured in multiple files will be scoped to the lowest level (either in the
"UserSettings.xml" file or the "ApplicationSettings.xml" file), including values that are pulled from the
old EnvironmentSettings.xml file.
IMPORTANT: Make sure the Content Matrix Console is closed when making updates to configuration
variable files.

EnvironmentSettings.xml File
This file allows users to configure general settings for all Product Editions. This means that these
settings only need to be set in a single file, either for all users of the machine (if users are required to be
local administrators) or for each individual user of the machine (if users are not required to be local
administrators) and can be found in one of the following locations:
· If you are required to be a local administrator on the machine where Content Matrix is installed: C:

\ProgramData\Metalogix
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OR
· If you are not required to be a local administrator on the machine where Content Matrix is installed:

C:\Users\<username>\AppData\Roaming\Metalogix\Common

UserSettings.xml File
This file allows users to configure general settings for all Product Editions for a specific user account
(the logged in account). This means that these settings will be configured for all Product Editions, but
only for the current user account. If another user would like to configure these same settings to work
for them, they must be configured manually under the appropriate user account. It can be found in the
following location:
C:\Users\<USER>\AppData\Roaming\Metalogix

ApplicationSettings.xml File
This file allows users to configure settings that are limited to the specific Product Edition of Metalogix
Content Matrix Console, for a specific user account (the logged in account). This means that each
Product Edition, for every user account, must be configuredindividually. While the
"ApplicationSettings.xml" file for each Product Edition can contain some of the same settings, there are
some settings that are Edition specific (for example, some settings may only work for eRoom Edition,
so they will only be available in eRoom Edition). Any settings that are replicated through various
version of the file will only be applied to the specific Edition.
For example, the "AllowCheckResults" setting is available in every "ApplicationSettings.xml" file, but it
must be set on an individual Product Edition basis. Setting it for SharePoint Edition will not configure it
for eRoom Edition. It can be found in the following location:
C:\Users\<USER>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition.

Client Side Configuration
For an individual Metalogix Content Matrix Console instance, you can Change the Managed
Metadata Migration Batch Size, and/or Configure Settings for Migrations Using the Import Pipeline.

Changing Resource Utilization Settings
How many threads can be used simultaneously per job in Metalogix Content Matrix is controlled by the
Edit Resource Utilization Settings option, which is accessible from the Settings ribbon at the top of the
Console UI.
If the option is clicked, a dialog containing a slider will appear that will allow control of the number of
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threads available within a single action. If the slider is moved all the way to the left, this will turn off
multithreading and only allow a single thread to be used during the action. (For more information on
threading, refer to the Microsoft article About Processes and Threads.)
NOTE: Turning off multithreading in this way can be a valuable way of troubleshooting whether
multithreading is causing issues.
If the slider is left in the middle, it will allow twice the number of processors in threads to be created
per action. For example, if the machine running Metalogix Content Matrix has a two core CPU, four
threads will be able to be used if the slider is in the below state:

Moving the slider farther to the right will allow more threads to be used, but can potentially overwhelm
system resources. This could lead to potential errors if the system resources cannot handle the data
being migrated. There is a chance that if the speed is too high, you would see a slowdown in the
overall migration, because the migration is trying to run actions faster than the resources properly
allow.
While this value can be set through the Content Matrix Console, you can also set it through the back
end, if the UI setting does not seem to be working for you. Please contact Quest Support for more
information on this back end setting.
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13
Frequently Asked Questions
This section answers some of the most frequently asked questions about using Metalogix Content
Matrix.

Keyboard Shortcuts
Question
Are there any keyboard shortcuts in the Metalogix Content Matrix Console? If so, what are they?

Answer
Yes, there are a few basic keyboard shortcuts within the Metalogix Content Matrix Console. They are:
· Ctrl + A - This will Select All items within the Items view or in any of the logging sections (such as the

Job List section or the Log Viewer).
· Ctrl + C - This will Copy any selected item(s) within Explorer view or Item view, including sites and

lists. It will also copy any selected item(s) or information within the logging sections (such as the Job
List section or the Log Viewer).
· Ctrl + V - This will Paste any selected item(s) within Explorer view or Item view, including sites and

lists. It will also paste any selected item(s) or information within the logging sections (such as the Job
List section or the Log Viewer).
· Delete - This will Delete any selected item(s). This applies to all views and items within Metalogix

Content Matrix.
· Ctrl + P - This will open the Properties dialog for any selected item in Metalogix Content Matrix, in

both the Explorer view and the Items view.
· Ctrl + S - This will open the Save dialog for the current Job list.
· F2 key - This will Rename any selected job list in the Job List in the main UI. Simply select the desired

job list, in the Job List section, press F2, and type in the new name for the job list.
· F5 key - This will Refresh any selected node in the Explorer View. This is the same as using the

Refresh node option in the context (right-click) menu.

Metalogix® Content Matrix Public Folder Edition
Frequently Asked Questions

143

Activating the License Key Silently
Question
I would like to activate my license outside of the Content Matrix Console. Is that possible?

Answer
You can activate your Content Matrix license using PowerShell. Follow the steps below.
NOTE: This method can only be used for online activations.
1. Open the Content Matrix PowerShell Console.
2. Run the following cmdlet, which includes specifying the Content Matrix Console Edition for which
you want to activate the license.
if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction
SilentlyContinue){ Set-MetalogixJobPrerequisites -Value "Content Matrix
Console - <Edition_name>" }

NOTE: Valid values for <Edition Name> are SharePoint Edition, eRoom Edition, Public Folder
Edition. If you license covers more than one Edition, it is only necessary to activate one. The
license activation will automatically be applied to any other Edition for which you are licensed.
3. Run the Set-MetalogixLicense cmdlet. Note that additional parameters are required if a proxy
server is used.
Without proxy server:
Set-MetalogixLicense -Key "<license_key>"

With proxy server:
Set-MetalogixLicense -Key "<license_key>" -ServerUrl
"<proxy_server_IP_addres>" -Port "<proxy_port_number>" -UserName
"<user_account>" -Password "<password>"

NOTE: When entering the license key, include hyphens.

License Key Troubleshooting
Question
I have been unable to get Metalogix Content Matrix to recognize my license key. When I copy and
paste it into the box, I get a "the specified license key is invalid" error.
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Answer
Here are some things to check:
· Make sure that the license covers the product edition. (For example, if you are licensed for

SharePoint Edition and Public Folder Edition and try to activate the license for eRoom Edition, the
invalid error will display.)
· Confirm that the license you are installing is for the correct application versions of Metalogix

Content Matrix. Contact Quest to verify that it is.
· When performing an offline key activation, make sure to enter the long key in its entirety, including

the "=" symbol at the end of it.
· Verify that you have write privileges to the registry. The installer will fail if the registry is locked. In

some cases there may be a group policy that is preventing the user from adding the key in the
registry, despite the user having the correct permissions.
· Some versions of Windows will automatically block write access to the registry under the user

account, even if that account has write access to the registry. In this case you can go to the
application installation folder, right click on the application .exe file, and choose 'Run as
Administrator'. Then re-enter the license key.

Using Proxies, Load Balancing or Alternate
Access Mappings
Question
How does Metalogix Content Matrix deal with environments that use proxies, load balancing and/or
alternate access mappings (AAM)?

Answer
Metalogix Content Matrix Console should not run into any issues with these three things. Metalogix
Content Matrix uses the Metalogix Extensions Web Service (MEWS), which deploys over a whole farm
and functions identically to a regular SharePoint web service. SharePoint web service's get the benefits
of IIS redirection, proxy pushing, and anything else that SharePoint can utilize, such as Alternate Access
Mappings (AAM). Since the Metalogix Extensions Web Service acts the same as a SharePoint web
service it also gets all of these benefits.
In the case for load balanced environments the Metalogix Extensions Web Service would need to be
deployed through the target side SharePoint farm. When the Web Service is installed it automatically
gets deployed to all the SharePoint instances within that farm, as a SharePoint solution. Once the Web
Service is installed on the target server, then load balancing should no longer be an issue.
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There are, however, some cases where proxy settings may not work correctly by default. In these cases
it is possible to set some specific proxy settings for the specified connection. Please see the
Configuring Proxy Settings page for more details, or the Manually Configuring Proxy Settings page if
the proxy settings need to be manually configured.

Errors Connecting to SharePoint 2019 or
SharePoint Server Subscription Edition in a
FIPS-Enabled Environment
Question
Why am I getting an error when I try to connect to SharePoint 2019 or SharePoint Server Subscription
Edition in a FIPS-enabled environment?

Answer
Content Matrix uses some assemblies for FIPS compliance that are not supported for certain
SharePoint 2019 and SharePoint Server Subscription Edition connections.
For a remote object model (MEWS) connection (displays for the top node) for SharePoint 2019:
Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request
failed with the error message: -- <!DOCTYPE html> <html>
For a local object model (OM) connection (displays at the item level for SharePoint 2019 and
SharePoint Server Subscription Edition):
The type initializer for 'Microsoft.SharePoint.ApplicationRuntime.SPRequestModule' threw an exception
In addition, errors will display in Browser View and Items View.
For SharePoint Server Subscription Edition, you can connect using a remote object model (MEWS)
connection.

Changing a Job Configuration for Multiple Files
Question
Is it possible to change the configuration for multiple job files at one time in the Job List section of
Metalogix Content Matrix?
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Answer
Yes, this is possible. Most users will only need to change the configuration of a single job in the Job List
section, but it is possible to change the configuration for multiple jobs at one time.
In order to modify the configuration for multiple job files at one, select all of the jobs in the Job List
section. Once all of the desired jobs are selected there are two methods that can be used to access the
configuration dialog. The first is to click the Change Configuration button at the top of the Job List,
and the second method is to open the context (right-click) menu, and select the Change configuration
for selected jobs option.
The behavior for changing the configuration of multiple files at once changes slightly depending on the
version of Metalogix Content Matrix Console that is being used.
Behavior in Versions 6.1.00 and Later
When changing the configuration for multiple files that use the same type of action at once, only
settings that are changed during the re-configuration will be pushed into all of the selected jobs. This
means that even if all of the jobs contain different settings, they will all still contain these different
settings after the configurations have been modified. Only the settings that were re-configured will be
changed (to whatever setting they were changed to).
Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a
different Rename action applied to it as well as a few various other differences in selected options.
When the Change Configuration is applied to all three at once, only the settings that were
reconfigured will be affected. So if the web part options were changed, then those options will be
applied to all three jobs, but each will still retain their original Rename setting, and any other settings
that were configured even if there are differences.
Behavior in Versions 6.0.0201 and Earlier
When changing the configuration for multiple files that use the same type of action at once, all of the
selected files will have the options for the first job in the Job List section pushed into them, regardless
of any other setting the previously used. Basically, all of the jobs after the first select job in the Job List
will be modified to use all of the settings from the Change Configuration dialog.
Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a
different Rename action applied to it as well as a few various other differences in selected options.
When the Change Configuration is applied to all three at once, all of the configuration options that are
set for the first of the selected jobs in the Job List will be pushed to the two remaining jobs. These two
remaining jobs would then use all of the exact same configuration options as the first job, including the
values for the rename options. Any of the previous settings for the two remaining jobs would be lost
(because they are replaced with the first jobs configuration options).
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SharePoint 2013 and 2016 Site Collection
Creation Issue
Question
I have been trying to create a new Site Collection in SharePoint 2013 or later through Metalogix
Content Matrix but I have been encountering issues. Why is this happening? and what can I do about it?

Answer
Starting with SharePoint 2013, most web applications use claims authentication, but the Central
Administration web application that manages the server level settings uses Classic authentication. When
Metalogix Content Matrix Console connects to a SharePoint server it has to authenticate through a
web application. When connected to a SharePoint 2013 or later web application that uses Claims
authentication, SharePoint itself can have trouble recognizing that the accessing User account has
permissions in the web application areas that are managed by Classic authentication. This is also true if
connected to a web application that uses Classic authentication, if trying to access an area managed by
Claims authentication.
In SharePoint 2013 and later, the permissions to create Site Collections is managed by Classic
authentication, so if connected through a Claims authentication web application users will receive a
"401 Unauthorized" error message when trying to create a new Site Collection. This happens even if
the user account has all of the appropriate permissions. If connecting through a Classic authentication
web application, users will receive permission errors when trying to set any settings on a Site Collection
that uses a Claims authentication web application, after the Site Collection is created.
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From internal testing, we have determined that SharePoint 2013 or later connections
that use the Local Object Model connection will not run into this issue. This is because
the Local OM connection type does not run authentication through IIS, which appears
to be a trigger point for the authentication issues.
From testing we have also determined that you are still able to create SharePoint 2013
or later Site Collections when using the Remote OM connection type, but in order to do
this Metalogix Content Matrix Console must elevate your permissions for the creation
step. Before elevating any credentials, Metalogix Content Matrix Console will run a
preliminary check to ensure the migrating user has enough permissions initially to be
able to use the elevated Site Collection creation. In order for these elevated
permissions to be used, the migrating user account must explicitly (by name) have "Full
Control" permissions on the Web Application that the Site Collection is being created
on.
In the Remote OM connection case users can also create a Site Collection within any
web application if they are a member of the Farm Administrator group in SharePoint
and they are connected to Central Administration as a farm connection.

Possible Errors when Creating Site Collection in SharePoint 2013
or later
Below is a list of errors (and their explanations) that you might encounter when trying to create Site
Collections in SharePoint through Metalogix Content Matrix Console.
· Error Message 1 - Unable to obtain Web Application '<web application name>'.

Explanation/Resolution - Metalogix Content Matrix is unable to find the web application. This
should not occur unless a serious issue within SharePoint has occurred from the time the Site
Collection configuration dialog was displayed, and the call to the Metalogix Extensions Web Service
(for remote OM connections) was made to perform the Site Collection creation. Check your
SharePoint environment, and resolve any issues. Then try again.
· Error Message2 - Migrating user '<migrating user>' requires explicit Full Control on the web

application where the site collection is intented to be created. If the migrating user is a member of
the Farm Administrators group then connect to the Central Administration site and try again.
Explanation/Resolution - The migrating user has read permissions on the web application (using a
farm or web connection type) that they're connected to, but does not have full control on the web
application that they are trying to create the Site Collection in. To resolve this, the migrating user
account must be added explicitly (by name) with Full Control to the respective Web Application that
they are trying to create the site collection in. They can also create a Site Collection within any web
application if they are a member of the Farm Administrator group in SharePoint, and they are
connected to Central Administration as a farm connection.
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Retrying Failed Document Copies to O365 CSOM
Connections
Question
When I try to migrate some of my content into O365 using a SharePoint CSOM connection type, and
this content contains a large Document Library, I see that some of my documents fail to migrate. The
logs for the failure indicate that a "HTTP 500 - Internal Server Error" was thrown. What is the cause of
this? And how can I fix it?

Answer
There is a potential issue when migrating specifically to SharePoint Online where users can encounter
an "HTTP 500" error. This is caused by a combination of the CSOM adapter and SharePoint's document
upload methods. To help resolve this issue there is a document retry feature that can be configured.
This retry feature will attempt to upload the document(s) into the SharePoint Online target, and
depending on the configured setting, will attempt to retry the upload process if it fails or times-out on
the initial try.
The below steps will explain how to enable and configure this retry setting.
NOTE: This retry method is only meant for migrating to SharePoint Online targets. If you are
migrating to an on premises target, then this retry feature will not benefit you since it makes use of
O365 specific methods.
1. Make sure that the Metalogix Content Matrix client application is closed.
2. In the file system that the Metalogix Content Matrix Console client application is installed on,
navigate to the the appropriate file location:
· If you are required to be a local administrator on the machine where Content Matrix is installed:

C:\ProgramData\Metalogix
OR
· If you are not required to be a local administrator on the machine where Content Matrix is

installed: C:\Users\<username>\AppData\Roaming\Metalogix\Common
3. In this location there should be an EnvironmentSettings.xml file. Open this file in an editor
program. For example, Notepad, etc.
4. There are two variables that will need to be modified in order for the retry method to work. They
are:
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· CSOMDocumentRetriesNumber - This value determines the number of times that Metalogix

Content Matrix will make another attempt to upload/migrate any document(s) that has failed the
initial document upload try, when migrating to a SharePoint Online CSOM target.
· CSOMDocumentRetriesDelay - This value determines the amount of time, in seconds (s), that

Metalogix Content Matrix will wait before starting a document upload retry, and is based on the
above ("CSOMDocumentRetriesNumber") variable.
NOTE: The default values for these two variables will be set as "0". Users can set these values as
desired, based on what works best for their environment.
5. After the desired values have been entered in the two variables, save and close the file.
6. Restart the Metalogix Content Matrix client application. The changes should now be in Metalogix
Content Matrix Console, and used when running any migration to a SharePoint Online target
environment.
After these values have been set and the client application has been restarted, any documents that fail
on the initial migration attempt we be retried.

Error Making a Browser-Based Connection with
PowerShell Console Open
Question
Why do I get a "Manual Reconnection Required" error when I try to run a Metalogix Content Matrix job
using PowerShell?

Answer
This error would occur if you used the Metalogix Content Matrix Console to connect to a SharePoint
target with Web Browser Authentication while the PowerShell console is open. To avoid this issue,
take the following steps:
1. Make sure that the PowerShell console is closed at the time you make a target connection via the
Metalogix Content Matrix Console when Web Browser Authentication is used.
NOTE: After entering your credentials, be sure to check the Remember my Password box, as
credentials must be stored in the Credential Manager vault before the connection is made.
2. After you have created your PowerShell job, close the Metalogix Content Matrix Console.
NOTE: At this point, it is recommended that you remove your Web Browser Authentication
credentials from Windows Credential Manager. You will be prompted to re-enter them when the
PowerShell job is run.
3. Launch the PowerShell console and run the job.
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4. When prompted, re-enter the credentials you used to connect via the Metalogix Content Matrix
Console. (Again, remember to check the Remember my password box.)

Support for GCC High Tenants
Question
Does Content Matrix support SharePoint Online GCC High connections?

Answer
Refer to the following table for specific target connections that Content Matrix supports for GCC High
tenants.
IMPORTANT: In order to use ADFS authentication with a GCC High tenant you must first run a utility
provided by Quest Support and enable the setting EnableUserProvidedAuthentication. Refer to the
Quest Support Knowledge Base article Enabling User Provided Authentication in Content Matrix for
details.
OAuth

OAuth with
MFA

ADFS

ADFS
(Office 365 User
Provided
Authentication)

--

--

--

--

--

Web Browser
Authenticatio
n

Office 365 Web
Browser
Authentication
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14
About Us
Quest creates software solutions that make the benefits of new technology real in an increasingly
complex IT landscape. From database and systems management, to Active Directory and Office 365
management, and cyber security resilience, Quest helps customers solve their next IT challenge now.
Around the globe, more than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver
proactive management and monitoring for the next enterprise initiative, find the next solution for
complex Microsoft challenges and stay ahead of the next threat. Quest Software. Where next meets
now. For more information, visit www.quest.com.

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and customers
who have trial versions. You can access the Quest Support Portal at https://support.quest.com
The Support Portal provides self-help tools you can use to solve problems quickly and independently,
24 hours a day, 365 days a year. The Support Portal enables you to:
· Submit and manage a Service Request
· View Knowledge Base articles
· Sign up for product notifications
· Download software and technical documentation
· View how-to-videos
· Engage in community discussions
· Chat with support engineers online
· View services to assist you with your product
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